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1 Using this tutorial

This tutorial is an easy way to learn how to use CTI Data
Connector for Salesforce. It is designed for all office workers
who want to  benefit from Computer Telephony integration.

While completing these lessons, you will learn how to make an
outgoing call, use the phone book or make the necessary
configuration settings for your PBX system.

Part I explains the basics for using CTI Data Connector for Salesforce features, including
how to make calls, receive calls or how to make personal configuration settings. Part II
provides hands-on experience for using additional features like expert settings or
database configuration.
 

Using the help

Use the buttons     in the upper right corner to browse through the online help. To

print one single page, use the button . Small images are enlarged if you click on it.

The Online Tutorial will be updated also after its release. In case you do not have Internet
access, you can select the Offline version  in the Configuration Wizard.

Print this tutorial

The Online Tutorial is also available as a PDF document.

You can print this tutorial - click on the link to download PDF file 

Update
Update Version 3 to version 4

Service Pack 4.0.3 is available  (October 2012)

 recently added 

Internal Phone numbers  (10/2012)

63

11

13

99

http://www.helpserver.biz/onlinehelp/cdc/sf/4.0/help2000/help-print.pdf
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Assign Cases to a phone call  (7/2012)
Support for Safari, Chrome, Firefox and Internet Explorer   (5/2012)

Copyrights and Trademarks

Copyright © Mirage Computer Systems GmbH. All rights reserved.

Information in this document is subject to change without notice. The software described
in this document is furnished under a license agreement or non-disclosure agreement .
The software may be used or copied only in accordance with the terms of those
agreements. 

This documentation and the accompanying materials are for informational purpose only
and property of Mirage Computer Systems GmbH. Information in this document is subject
to change without notice. The names of companies, products, people, characters, and/or
data mentioned herein are fictitious and are in no way intended to represent any real
individual, company, product, or event, unless otherwise noted. 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted
in any form or any means electronic or mechanical, including photocopying and recording
for any purpose other than the purchaser’s personal use without the written permission of
Mirage Computer Systems GmbH.
 

All products and company names mentioned herein may be the trademarks of their
respective owners.
www.cti-data-connector.com

CTI Data Connector for Salesforce Version:  4.0.3 

This document was updated: 27.11.2012
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2 Software Update

Right click on the the red salesforce icon , select info. The CTI Data Connector
Version should be 4.0.3 or higher .

Update Version 3 to 4

Service Pack 4.0.3

2.1 Update Version 3 to 4

Modification history version 4

For a complete list of all modifications click here

Call Center Adapter / SoftPhone

Works with Internet Explorer, Firefox, Chrome and Safari - Details see
Browser Support
Outgoing call from a task with a phone number, which is stored in multiple
contact records. The phone note will be automatically assigned only to the
contact who is assigned to the task
Outgoing call from a case. The phone note is automatically assigned to this
case. Necessary configuration settings
Adapter with default values for Germany  and USA / Canada
Displays a logo in the SoftPhone
Additional optimization for supported telephone number formats for incoming
and outgoing calls. The phone number listed below will be recognized with
incoming calls and for outgoing calls, the numbers are reformatted so that the
PBX can use it to dial.

Numbers in brackets are samples if the caller is located in the USA.

+49 7525 5293-39 (+1 646.257.3801)

0049/752593-39  (011 1 646.257.3801)

+49 (0) 7525529339  (+1 (1) 646.257.38)

0049(0) 7525/529339 (0111 (1) 646.257.3801)

004907525/529339 (0111 1 646.257.3801) this is not a valid phone number
format  but it would work nevertheless
07525/529339  (1 646.257.3801)

529339 (257.3801)
Link: My Calls Today works with different date formats

11

13

85

97

89 89



12 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

CTI Data Connector for Salesforce

New option: right mouse click : About Mirage Computer Systems GmbH.
Displays the version number

The offline help is no longer included in the download package 

Configuration Wizard

TAPI driver name includes the extension number
 Remove a prefix for incoming calls (e.g.. TAPI driver sends 007525529339) 

Installer

Installs .NET 3.5 Framework if not installed yet
Automatically uninstalls version 3 or beta version 4
At the end of the installation a help  to check the SoftPhone is displayed
Improved 'Silent' Installation  to support the rollout of a large number of
workstations

Update Eligibility

The update is free, if version 3 was bought after May, 1st 2012 or you have a valid update
subscription which expires after June 10th 2012.

Installation of the Update

The update requires a full new installation and a new Serial Number. You will
automatically get a Serial Number. In case you don't get one, contact  Support@mirage-
systems.de.

Uninstalling version 3 is not required (this will be done automatically).

Singe User Installation

Click here to download the update (includes the latest service pack)

Install Call Center Adapter  4. You can transfer the values from adapter 3  

Delete Call Center Adapter 3. If you update multiple single user installations, you can
also remove a user from call center adapter 3 and add the user on adapter 4
Uninstall version 3 (Control Panel, Programs and Features)

Proceed with the steps explained here: Single User installation . 

Activate the product with a new Serial Number

Network Installation

Version 3 and version 4 can be used at the same time. This allows you to make the
transition for the workstations gradually.

102

121

87

100

134

http://www.mirage-systems.info/download/CDC/full-version/salesforce/4.0/4.0.3/cdcsfinstall40.exe
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Click here to download the update (includes the latest service pack)

Install Call Center Adapter  4. You can transfer the values from adapter 3  

Server installation 

Install one Client / Workstation  and activate the product with a new Serial Number

Remove a user from call center adapter 3 and add the user on adapter 4

Uninstall version 3 on the user machine (Control Panel, Programs and Features)

Install additional clients / workstations

2.2 Service Pack 4.0.3

Modification history version 4.0.3

For a complete list of all modifications click here

Call Center Adapter / SoftPhone

Internal Calls  are saved as an activity with the call type: Internal Call
Incoming internal calls - The phone number is searches in the salesforce 
user fields phone and extension
New option - Expert Settings
Call transfer using a hand set updates the phone status within the SoftPhone
Salesforce Adapter Version 4.0.2 is installed. This fixes a bug with lost
connections where the SoftPhone did not respond after some time
The log files for the salesforce adapter is now enabled when the log file option
of  CTI Data Connector for Salesforce is checked

CTI Data Connector for Salesforce

Crash when line is busy (only Cisco)

Configuration Wizard

New Options: Use dialing rules for incoming calls, Use dialing rules for
outgoing calls

Installer

Changes for the Silent Setup

Update Eligibility

The update is free for all users of version 4.

87

120

121 134

121

99

97

122

http://www.mirage-systems.info/download/CDC/full-version/salesforce/4.0/4.0.3/cdcsfinstall40.exe
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Installation of the Update

The update requires a new installation of the Call Center Adapter.

Uninstalling version 4 of CTI Data Connector for Salesforce is not required.

Singe User Installation

Click here to download the update

Change the name of the call center adapter 4.0

Install Call Center Adapter  4.0.3. You can transfer the values from adapter 4.0
manually
Proceed with the steps explained here: Single User installation . 

Either remove each user assigned to the adapter 4.0 depending on the installation
progress or delete the adapter 4.0. This will remove all users. Assign the user(s) to
adapter 4.0.3

Network Installation

Version 4.0 and 4.0.3 can only be installed at the same time, if version 4.0.3 is installed on
a separate network folder. This allows you to make the transition for the workstations
gradually. If the installation is done into the same folder, all workstations have to be
updated immediately. 

Click here to download the update

Change the name of the call center adapter 4.0

Install Call Center Adapter  4.0.3. You can transfer the values from adapter 4.0
manually

87

100

87

http://www.mirage-systems.info/download/CDC/full-version/salesforce/4.0/4.0.3/cdcsfinstall40.exe
http://www.mirage-systems.info/download/CDC/full-version/salesforce/4.0/4.0.3/cdcsfinstall40.exe
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Server installation . In case you installed version 4.0.3 into a new folder, copy the
license file cdcsfe.lic from the old folder into the new folder.
Install one Client / Workstation

Either remove each user assigned to the adapter 4.0 depending on the installation
progress or delete the adapter 4.0. This will remove all users. Assign the user(s) to
adapter 4.0.3
Test the new version making an outgoing and incoming call

Install additional clients / workstations

120

121

121
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3 Part I - learning the basics

3.1 About Part I

CTI Data Connector for Salesforce is an application which responds to incoming and
outgoing calls in background mode. The only precondition for your PC / telephone
system is a TAPI interface . CTI Data Connector for Salesforce supports both a First
Party solution (a phone is connected via serial interface or USB to the PC) and a Third
Party solution (CTI Server).

CTI Data Connector for Salesforce can be configured individually for every PC and is
available with different options. Therefore you may not be able to use specific functions
although they are described here.

Before you start using CTI Data Connector for Salesforce you have to set the
configurations for the telephone system and the database(s). Normally, this is done during
the installation. It is essential to make some basic configuration settings which are
described in the chapter Minimum Configuration .

148

22
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4 Introduction

4.1 Start the Application

CTI Data Connector for Salesforce is either started automatically with the operating
system or you start it within the program manager group CTI Data Connector for
Salesforce . After starting the program you will find an Icon in the system tray (notification
area, down to the right near the date and time display).

CTI Data Connector for Salesforce is ready and will respond to incoming and outgoing
calls. The icon in the taskbar will respond to clicks made with the left and right mouse
button. For details see chapter taskbar - Control Basic Functions .

 You have to type in you salesforce login name and salesforce data before you can
use  CTI Data Connector for Salesforce. If you get an error you probably have to install the
salesforce Desktop Integration, Connect for Office - see details chapter Install Connect
for Office.

 

By default, the icon is not visible on Vista and Windows 7 in the notification area. To show

the icon  for CTI Data Connector for Salesforce in the system tray, click on the up
arrow. Click on Customize.

This will open the Notification Area Icons control panel item. Select the icon for  CTI Data
Connector for Salesforce and in the pick list select: Show icon and notification.

23
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Additionally add the red salesforce icon  

4.2 Welcome Screen

By default, the Welcome Screen is opened after each program start. This screen
provides you with:

Links to most popular FAQ to get started

Link to Online Knowledge Base

Link to updates

The screen can be deactivated by checking Do not display this Quick Introduction help
anymore when starting and activated again in the Configuration Wizard, Display Quick
Introduction Help .64
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 If you don't have an Internet connection, select offline help. You also can change
this setting in the configuration wizard, expert settings, screen Help and Welcome .

 Depending on the program version, some options could be not available.

63
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4.3 Minimum Configuration Settings

During installation, the Configuration Wizard  was already started. You can define a lot
of individual configuration settings there. The following settings have to be defined to
guarantee a basic functionality.

TAPI device driver  - it is delivered by the telephone manufacturer. See also: System
requirements - TAPI driver  . If you don't have a TAPI driver yet, you can use the
Telephone Simulator  for testing.
Button Dialing Rules  - configures country settings and area code. See also special
configuration for US / Canada

Just by setting this minimum configuration you will be able to make outgoing calls and to
identify incoming calls. The Configuration Wizard can be started any time by right click
on the icon , option Configuration Wizard .

51

54

148

27

70

71

23 51
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See also

Where do I find the TAPI driver?
System requirements - TAPI driver

 
 

4.4 Taskbar - Control Basic Functions

After the program start, the taskbar (notification area, down to the right near the date and
time) will display the icon

CTI Data Connector for Salesforce is ready and will respond to incoming and outgoing
calls.

You can control basic functions via the icon 

with a single click on the right mouse button you select options such as redialing or
service programs
with a single click on the left mouse button you operate phone functions (pick up call,
hold, transfer , hang up)

During the signaling of a call by the Desktop Notification the control via the taskbar icon
will not be available.

Hovering above icon with the mouse pointer

If you hover above the icon with the mouse pointer, the message CTI Data Connector for
Salesforce - 0 call(s) will appear. The amount of  incoming and outgoing calls during the
last restart will be displayed.

The options in detail:

Blue Icon - Left Mouse Click

Blue Icon - Right Mouse Click
 

150

148

43

24

24



24 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

4.4.1 Blue Icon - Left Mouse Click

Single left mouse click on the blue icon 

This function will be only available during an active call and is designed for phoning with
a headset. The individual options will be displayed depending on the status of the call.

When ringing: Answer, reject or transfer  call

When the call is active: Hold, transfer  or disconnect call. If the call is on hold, you
will have these options: Answer or Disconnect

4.4.2 Blue Icon - Right Mouse Click

Single right mouse click on the blue icon 

Here you can choose from different options. Depending on the configuration it is possible
that not all options will be available:
______________________________________________
Configuration Wizard - starts the Configuration Wizard

Show License Information  - displays the license information

Help - opens this tutorial - the type of the help system (Online / Offline ) can be set in
the configuration wizard
About CTI Data Connector for Salesforce -  display version information
______________________________________________
Restart Salesforce SoftPhone

______________________________________________

Quit - Terminates CTI Data Connector for Salesforce

4.5 First Steps

After starting  CTI Data Connector for Salesforce you can access all functions via the
icon in the taskbar .

To practice, try to make an outgoing call using the Hotkey , which should work with all

43

43

51

77

63

154

19

23

34
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applications.

4.6 Navigation within the Control Centre

Nearly all functions can be accessed via the file menu, the toolbar  or by clicking on the
right mouse button above the Icon in the taskbar.

 

File Menu

                Status
line

Toolbar

Overview over the File Menu

File

Close: Closes the program window, but does not terminate the application

Quit: Terminates CTI Data Connector for Salesforce

Edit

Cut: Deletes the selected text and copies it to the clipboard

Copy: Copies the selected text to the clipboard

Paste: Pastes the contents of the clipboard into the selected field

Delete: Deletes the selected text

24

25

24
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Quick Dialing: Displays a submenu of the quick dialing list (only available within quick
dialing)
List: Displays a submenu within the call history list (only available within this list)

Search: Displays the phone book for searching for an address

View

Call information: displays call information

Phone and Quick dialing: Displays the phone and the quick dialing list for outgoing
calls
Phone book: Displays the phone book for searching for an address

Call History (outgoing / incoming calls): Displays the call history

Extras

Format phone numbers: Activates the function for formatting the phone numbers

Configuration Wizard: Starts the Configuration Wizard

Error protocol: Displays a log  of the last system messages

Always on top: Defines whether the control centre of CTI Data Connector for
Salesforce will always in the foreground when a call is coming in (the window will
cover any other applications and you cannot switch to them) or whether the control
centre will pop up and you can switch to other applications

Compact salesforce database: Compact the salesforce database for caller
identification. This is normally done automatically 

?

Help: Displays context-sensitive help information (help for the currently displayed
screen)
Contents: Displays this tutorial

CTI Data Connector for Salesforce on the Web: Displays the internet page of CTI
Data Connector for Salesforce
Software Service: Checks for new Updates

%OEMNAME%> on the Web: Displays the website of Mirage Computer Systems
GmbH
About CTI Data Connector for Salesforce: Displays version information about the
installed application

79

51

81

11
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Show License Information: Displays the purchased licenses  and allows to type
in Activation Keys for adding new licenses

The following options are only available after the product was activated (full version)
Backup License - make an online backup of the license file

Restore License - restore the online backup of the license file

Deactivate License - transfer the license to another PC

4.7 Phone Simulator

If you have no TAPI-enabled phone available and you want to test CTI Data Connector for
Salesforce, you can use the simulator which works like a regular telephone.

Activating the Simulator

Start the Configuration Wizard  and choose the page where you can select your
telephony service provider . Choose <Telephone Simulator>. When you start CTI
Data Connector for Salesforce, the simulator will be started automatically.

Working with the Simulator

The telephone simulator acts like a normal telephone with which you can make outgoing
calls and accept incoming calls.

77

51

53
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Type in phone
number

 

 

 Button for Dial,
Pick up, Hang up

 

 

 

 You can use the
keyboard to make
a call

Simulating an incoming call

Type in a phone number (without country code and special characters) in the display.
You can alternatively use the keyboard to type in the number.
Press the button Dial

CTI Data Connector for Salesforce performs the caller identification and signals the
incoming call
Accept the incoming call by pressing the button Pick up

You can disconnect the call by pressing the button Hang up

Simulating an outgoing call

Search in the phone book of CTI Data Connector for Salesforce for an address or a
contact person and dial by double-clicking on the phone number. You can dial
alternatively by highlighting a phone number  and pressing the configured Hotkey .
CTI Data Connector for Salesforce displays the dialled address

Establish the call by pressing the button Pick up

You can disconnect the call by pressing the button Hang up

34 56
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5 Make Phone Calls

5.1 Outgoing Calls

CTI Data Connector for Salesforce provides multiple options to make an outgoing call
dependent on the application your are using. The option Dial with an Hotkey  should
work in any application.

All available options are:

Dial within Salesforce

Dial using a Hotkey

Dial within the Browser

Dial with a Hyperlink

Dial using the Clipboard

Redial  using the last called phone number

Dial using the telephone set   - the dialled address will be displayed

By default, the icon is not visible on Vista and Windows 7 in the notification area. To show

the icon  for CTI Data Connector for Salesforce in the system tray, click on the up
arrow. Click on Customize.

This will open the Notification Area Icons control panel item. Select the icon for  CTI Data
Connector for Salesforce and in the pick list select: Show icon and notification.

Additionally add the red salesforce icon  

34

32

34

35

36

38

38
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5.1.1 Format of a Telephone Number

CTI Data Connector does not care whether phone numbers are stored unstructured or
include special characters. It is only important that the numbers comply with the
international phone number format. Telephone numbers can be stored as follows:

Numbers in brackets are samples if the caller is located in the USA.

+49 7525 5293-39 (+1 646.257.3801)

0049/752593-39  (011 1 646.257.3801)

+49 (0) 7525529339  (+1 (1) 646.257.38)

0049(0) 7525/529339 (0111 (1) 646.257.3801)

004907525/529339 (0111 1 646.257.3801) this is not a valid phone number format  but
it would work nevertheless
07525/529339  (1 646.257.3801)

529339 (257.3801)

After the country code the number 0 should be surrounded by brackets or be omitted. If
the number 0 is not surrounded by brackets, then CTI Data Connector for Salesforce
uses the dialing settings stored in windows to either truncate the 0 or leave the 0 (e.g. for
Italy). 

Example

004402089481345 would result in 00442089481345

003902089481345 would result in 003902089481345

 

 

 

5.1.2 Necessary configuration settings for outgoing calls

Below find a list of configuration settings which have an impact on outgoing calls. If
outgoing calls are not working, check these settings and also check Troubleshooting -
Outgoing calls .

Configuration Settings

Select correct TAPI driver

PBX Configuration  - especially dial tone digits for external calls

Dialing Rules  - for US / Canada check additional settings

TAPI Configuration - Prefix Outgoing Calls

TAPI Configuration - Provider Postfix

TAPI Configuration - Ignore Fake Number
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Dial via Hotkey  - configure  Hotkey and activate this option

Dial within Browser  - activate this option

Dial with a Hyperlink  - activate this option

If internal numbers are not dialled correct, check:

TAPI Configuration - Prefix internal number

Minimum length  of phone number indicating an external call

5.1.3 Dial within Salesforce

There are different options to make an outgoing call (requires the installation of the
salesforce call center adapter)

Making a Call Using Click-to-Dial

All phone numbers will have a green phone icon .

To make a call directly from the phone field of a contact, lead, activity, or account 

Locate the number that you want to dial in a contact, lead, activity, or account.

Click the  button to the right of the number. The number is automatically dialed in the
first open SoftPhone line. 

Note
A number that has already been clicked cannot be clicked again for five seconds. 

The button does not appear next to fax numbers.

Use the SoftPhone to dial

You can type in a phone number in the SoftPhone

In the SoftPhone, click the name of the open line that you want to use. This action
opens the dial pad for that line.
Enter the phone number that you want to dial by clicking the number buttons on the dial
pad, or by typing numbers on your keyboard.
Click Dial or press the Enter key on your keyboard.

34 56 53

35 53

201 53

61

70

87



33Make Phone Calls

© 2012 Mirage Computer Systems GmbH

Making a Call Using the Call Center Directory

To make a call using the call center directory: 

In the SoftPhone, click the name of the open line that you want to use. This action
opens the dial pad for that line. 

Click  next to the dial pad to open your call center directory.

Use the directory to locate the number that you want to dial.

When you have found the number, click the name associated with the number to
automatically enter the number into the dial pad.
Click Dial or press the Enter key on your keyboard.
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For more information about the salesforce call center adapter search in the salesforce
online help using the search term: call center adapter overview

5.1.4 Dial with a Hotkey

In nearly any application a phone number can be highlighted and dialed using the Hotkey
defined in the configuration settings . The default value is the key F10.

Highlight the phone number within the Web Browser by pressing down the left mouse key
and dragging the mouse cursor to the right. When reaching the end of the phone number,
release the left mouse button and press F10.
In the example below a phone number has been highlighted. It can be dialed using the
defined Hotkey.

56
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See also

Troubleshooting - Hotkey is not working
Configuration - Hotkey to dial with a highlighted phone number
Configuration - Activate dialing via Hotkey

 
 

5.1.5 Dial within the Browser

Within an Browser any phone number can be highlighted and dialled with 2 different
options.

Highlight the phone number within the Web Browser by pressing down the left mouse key
and dragging the mouse cursor to the right. When reaching the end of the phone number,
release the left mouse button. You can dial:

Using the right mouse button. The option Dial with CTI Data Connector for
Salesforce will be displayed

Using a Hotkey

In the example below a phone number has been highlighted within a browser application.
It can be dialled using the Hotkey or right mouse click, Dial with CTI Data Connector for
Salesforce. You have to activate Dialing within Browser and Dialing via Hotkey  within
the configuration settings .
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 Dialing with right mouse button is available only in the Internet Explorer

See also

Enable dialing within Browser 

5.1.6 Dial with a Hyperlink

It is possible to instantly use the option Dial with a Hotkey  to dial. An optimum
integration can be achieved by using a link to dial within the Lead, Contact or Account
page. 

Advantage
It is just one click instead highlight a phone number and press a key

57
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You can dial from any list view or report

Disadvantage
You need to implement a field in salesforce.com for each phone number

To implement the function you have to create a new custom formula text field. This is
explained for contacts.

1. Within Salesforce, select Setup, Customize, Contacts, Fields
2. Create a new custom formula field of the type Text
3. Name it “Call Main Phone”

4. Use this syntax HYPERLINK("callto://"&Phone,"Click to dial")
5. Change the layout for the contact page so that the new "Call Main Phone" field is

directly under the "phone" field.

You can add the mobile phone number with another formula field.
HYPERLINK("callto://"&MobilePhone,"Click to dial")

Your screen should look like this

  

Add the fields for the Account and Lead screen.

Account: HYPERLINK("callto://"&Phone,"Click to dial")
Lead: HYPERLINK("callto://"&Phone,"Click to dial")

Create smart views and reports 

The new fields can be added in any Views or Reports. This allows dialing directly from the
view: ‘all open leads’ or any report.
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See also

Enable Dial with a Hyperlink 
Troubleshooting - Dial with a Hyperlink is not working
Configuration - Application used for dialing with Hyperlink

 

5.1.7 Dial with the Clipboard

CTI Data Connector for Salesforce is able to analyze the clipboard contents and to extract
a phone number.

If you copy a phone number using CTRL+C / Edit Copy into the clipboard, you can dial
the number by clicking on the icon in the taskbar  with the right mouse button and
selecting the option dial from clipboard. CTI Data Connector for Salesforce will analyze
the clipboard contents and dial the first phone number found.

See also

Troubleshooting - Hotkey is not working
Configuration - Hotkey to dial phone number from the clipboard

 

5.1.8 Redial - using last called phone number

This option is only accessible with a right click on the phone icon , option Redialing. It
dials the phone number last used.

5.1.9 Dial with the Telephone Set

You can dial with your telephone set just as you have done previously. CTI Data
Connector for Salesforce will recognize this dial automatically displaying the address with
the contact person you are calling either within the Desktop Notification window or the
caller information box.
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5.2 Incoming Calls

CTI Data Connector for Salesforce offers a sophisticated caller identification. 

 
The phone number of the caller is searched in Leads, Accounts or Contacts and
displayed in the SoftPhone . 

Watch a demo video

5.2.1 Video Tutorial

First watch the video, how the caller identification is working. Click on an image to start
the video.

Video Tutorials

Tutorials

41

39

http://www.helpserver.biz/onlinehelp/cdc/sf/3.0/tutorial/incoming/sf-incoming.htm


40 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

5.2.2 Necessary configuration settings for caller identification

Below is a list of configuration settings which have an impact on the caller identification. If
the caller identification is not working, check these settings and also check 
Troubleshooting - Incoming calls .

Address information used for caller identification
Salesforce Lead, Account, Contact

Addresses stored in the PBX system

Configuration Settings

Select correct TAPI driver

Configuration Caller Identification

TAPI Configuration - truncate incoming phone number at

TAPI Configuration - Prefix incoming call

TAPI Configuration - Don’t signal updated phone number during a call

If internal numbers are not identified correct, check:

TAPI Configuration - Prefix internal number

Minimum length  of phone number indicating an external call
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5.2.3 Salesforce SoftPhone

Incoming calls are signaled in the salesforce SoftPhone on the left side of the screen. 

SoftPhone 

Depending on the call state, buttons are enabled or disabled e.g. to hold or end a call.

The fields, which are displayed on the SoftPhone , can be configured in the SoftPhone
Layout  

You can can type in a phone note (comment) which is automatically saved in the activity
history including the call type (incoming / outgoing call) and call duration.

92
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Call Result (Wrap Up)

After the call is terminated, you can benchmark the call by selecting a Call Result. This
feature has to be turned on in the call center adapter configuration . It is saved with the
phone note as an activity and is available for reporting . See Call Center Reports in
salesforce.

For more information about the salesforce call center adapter search in the salesforce
online help using the search term: call center adapter overview

5.2.4 Missed Calls (red icon)

If a call is missed, the phone icon turns red  . You can now: 

Left mouse double click on the icon to directly open the dialog for missed calls

Right mouse click on the icon, select Call History (incoming calls) - opens the dialog for
missed calls

91
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After opening the Call History, the icon color turns back to blue .

 Anonymous calls are not signalled as missed calls.

5.3 Transfer a Call

Call Transfer allows to transfer a call from your phone to any other phone. This feature is
only available during an active call.

A call transfer is a mechanism that enables a user to relocate an active call to another
telephone by using the call transfer button and dialing the required location. The
transferred call is either announced or unannounced (blind transfer).

If the transferred call is announced, the desired party/extension is notified of the
impending transfer. This is done by putting the caller on hold and dialing the desired party/
extension; they are then notified and, if they choose to accept the call, it is transferred
over to them.

On the other hand, an unannounced (blind) transfer is self-explanatory: it is transferred
without notifying the desired party/extension of the impending call. It is simply transferred
to their line typing in the phone number and terminating the call.

Both options (announced and blind) are supported by CTI Data Connector for Salesforce 
but not by all TAPI drivers. If a TAPI driver does not support the transfer feature, this
option will not be available in CTI Data Connector for Salesforce.

 The way how this feature works in detail depends on the PBX and TAPI driver.

5.3.1 Announced Transfer

If the transferred call is announced, the desired party/extension is notified of the
impending transfer. This is done by putting the caller on hold and dialing the desired party/
extension; they are then notified and, if they choose to accept the call, it is transferred
over to them.

During an active call you can either
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Left click on the phone icon an select Transfer Call or

Use the Transfer Call button within the Control Centre

A new screen appears. Type in the number to which the call should be transferred and
press the button Transfer Call. 

You then have 2 options:

Press Back to Active Call to talk again with the caller or

Press Complete Transfer to transfer the call to the desired party

See also

Blind Transfer

 

5.3.2 Blind Transfer

A blind transfer is a call without notifying the desired party/extension of the impending
call. It is simply transferred to their line typing in the phone number and terminating the
call.

During an active call you can either

Left click on the phone icon an select Transfer Call or

Use the Transfer Call button within the Control Centre

A new screen appears. Type in the number to which the call should be transferred and
press Blind Transfer. The call is transferred to the desired party. 
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See also

Announced Transfer

 

5.4 Service Cloud Console

The Service Cloud Console requires a special setup within Salesforce. See Salesforce
help for detail information.

The SoftPhone options in the Service Cloud Console are a bit different in comparison to
the standard Salesforce setup.

- Video - Service Cloud Console

Main Screen - Service Cloud Console

Using the Service Cloud console, the SoftPhone is hidden in the lower right corner of the

window. Click on the icon  to open the SoftPhone

43
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Service Cloud Console - Main Screen

Incoming Call

Incoming calls are signaled in the Salesforce SoftPhone on the right side of the screen.
The Lead/Account/Contact details are displayed in a new TAB. For more details of the
SoftPhone functionality see Salesforce SoftPhone 41
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Incoming Call - SoftPhone

Interaction Log

The special feature of the Service Cloud Console is the Interaction Log. You enter the
phone note in the Interaction Log and not in the SoftPhone. When the phone call ends, the
data is automatically saved as an activity.
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Interaction Log - Enter phone note

5.5 Reports

All phone calls are stored as a task and are a available in salesforce reports. The default
salesforce call center reports can be found in the folder: Call Center Reports.

You can create any type of reports like

Incoming calls of a day or week

Calls where nobody could be reached (call duration is empty or 0)
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Report about the call results

If you create a report select report category: Activities and report type: Tasks and
Events

Example

42
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6 Configuration Wizard

6.1 Introduction

The Configuration Wizard of CTI Data Connector for Salesforce offers several steps for
making configuration settings. You can navigate through the pages with the buttons Next
and Back. To apply the new settings, the program for formatting phone numbers  will
be automatically started on the local PC.

The Configuration Wizard can have different options and steps depending on the
installation. The maximum is 6 steps and an introduction page. Note that this description
may differ from your installation. It is mandatory to configure the minimum configuration

.

How to start the Configuration Wizard?

Start the Configuration Wizard by clicking on the icon in the taskbar  with the right
mouse button and select the option Configuration Wizard or select the menu Extras -
Configuration Wizard in the control centre .

Overview of all configuration steps

Introduction - Select the language  for CTI Data Connector for Salesforce

Configuration of the TAPI device driver , Hotkeys , Expert Settings  and Browser
Dialing
Configuration of thePBX  and Caller Identification
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6.2 Select Language

Language

You can select the language for the application. 

Skin (Design)

A skin changes the look & feel (design) of the application. Just try to find the one you like
best. 
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Skin in
Design
Racer
Green

Skin in Design Wine 
  

If you want to skip this screen in the future, deselect Always show this page.

6.3 TAPI device driver , Hotkey, Expert Settings, Browser Dialling

Here you can configure the TAPI driver  and the dialing options which should be
activated.

Activate dialing within a Browser

Activate dialing via Hyperlink

Activate dialing via Hotkey

If available, the dialog for Expert Settings  can be started. Using the button Hotkey ,

54

57

57

56

58 56



54 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

you can configure the Hotkey  combination for outgoing calls. 

6.3.1 TAPI Driver

Select the TAPI device driver for incoming and outgoing calls from the list box. See details
for TAPI - Where do I find the TAPI driver?

With the button  a window can be opened where all functions supported by the TAPI
driver will be shown.

With the driver <Telephone Simulator> CTI Data Connector for Salesforce can be
tested with a phone simulator  if no TAPI enabled phone is available.
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If your TAPI driver is not listed here see: I cannot select my TAPI driver in the configuration
wizard

See also
Where do I find this screen?
System Requirements - TAPI driver
Where do I find the TAPI driver?
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6.3.2 Configure Hotkeys

Hotkeys are used to dial with a shortcut from any application. You first have to select 
Activate dialing via  Hotkey  before it can be used. Press the button Hotkey for
configuration. 

Hotkey to dial highlighted phone number

This Hotkey allows to dial by highlighting a phone number and press the Hotkey. For
details see Dial with a Hotkey . The default value is F10.

You can choose any
key combination (e.g.
CTRL + ALT + F10)
for outgoing calls. You
should select a
combination that is not
used by other
programs.

Hotkey to dial phone number from the clipboard

This Hotkey allows to dial a phone number which is stored in the clipboard. For details
see Dial with the Clipboard . The default value is CTRL + MENU + SHIFT + W to make
sure that other programs are not affected. If you use this functionality change the default
to a value which:
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is not used by other programs 

which can be accessed easily - e.g. CTRL+C = Copy value to clipboard - CTRL + D =
dial (note: CTRL D could be used by other applications for the delete function) 

Hotkey - waiting time to read clipboard

If the Hotkey for dialing is not working, then either the Hotkey is already in use (change
Hotkey) or other applications like the Office clipboard manager are blocking the clipboard.
The Hotkey copies the phone number into the clipboard and therefore needs access to
the clipboard. Increase the waiting time before information of the clipboard will be read.
The time is specified in a thousandth part of a second. Default time is 10 = 1 hundredth
part of a second. The maximum value is 98.

See also

Where do I find this screen?
Troubleshooting - Hotkey is not working
Dial with the Clipboard
Dial with a Hotkey

 

6.3.3 Configure dial options for Browser

There are 2 Browser options which can be enabled.

Activate dialing within Browser

This option allows to dial via right mouse click within the Browser. For details see Dial
within the Browser .

 Dial with right mouse button is available only in the Internet Explorer

Activate dialing via Hyperlink

This option allows to dial via Hyperlink. For details see Dial with a Hyperlink .

Dialing via Hotkey  is also working within a Browser.
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See also

Where do I find this screen?
Troubleshooting - Dial with a Hyperlink is not working
Configuration - Application used for dialing with Hyperlink

 

6.4 Expert Settings

CTI Data Connector for Salesforce allows to configure a lot of additional settings which
have an impact on:

Handling of a call

Provide a workaround for TAPI driver issues

Handling of the development interface to other applications

and other specific settings

 Only experienced users should change these settings

Depending on the system configuration, this option can be disabled. Otherwise press the
button Expert Settings in Step 1 of the Configuration Wizard.
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6.4.1 TAPI Configuration

The following settings have an impact on the TAPI interface or call handling.

External call - Prefix

If the TAPI driver adds a prefix for an external call, this prefix can be removed. Otherwise
prefixes can be added before the number is dialed. 

Example
The phone number 0734273830 is signalled as 00734273830. In this case the prefix 0 has
to be removed to allow a correct caller identification.

If the TAPI driver signals the incoming phone number without a leading 0, then
configure: Place prefix, Incoming.

Example
The phone number 0734273830 is signalled as 734273830. In this case the prefix 0 has to
be added for incoming calls to allow a correct caller identification.
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 By default, the prefix to get an outside line is added as Outgoing, cut prefix to
automatically remove the prefix after dialing. 

Prefix for internal numbers

This function allows to place a prefix in front of an internal number. It is not used for
dialling - only for incoming and outgoing caller identification. 

Example
For all employees the complete phone number is stored in the database, e.g.
07342/7383-12. For an incoming call, only the extension number is signalled, 
e.g. 12. In order to find the name of the calling person, the prefix 7383 has to be added.
Additionally, CTI Data Connector for Salesforce adds the area code, configured in the 
country settings .

Configure 7383 for the prefix which will firstly create the number 738312 and then will add
the area code. This results in the new number 07342738312 which will allow to identify
the caller. 

Provider Postfix 

This function allows to add a postfix at the end of a phone number for outgoing calls.

Example
IP providers often require a # at the end of the phone number to dial the number instantly. 

Configure # for the postfix which would dial 07342738312#

Truncate incoming phone number at:

This option is needed with IP phones and a TAPI driver which passes the phone number
with IP information.

Example
The phone number is passed as 0734273830@myprovider.com. This option allows to
truncate all characters after the specified character - e.g. @.

Ignore Fake Number

Some TAPI drivers firstly send a special number for outgoing or incoming calls and
then the correct phone numbers. To allow for the special number being treated as a fake

53
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number being ignored, configure the fake number.

Example
The TAPI driver firstly sends 879 and then the correct phone number.

Configure 879 as the fake number.

You can configure a list of numbers, separated by a semicolon. 

Example
879;888;890

Don’t signal updated phone number during a call
If a phone number changes during a call (e.g. because the call was redirected from the
main switchboard), the new phone number will be updated by default in the Desktop
Notification. The update can be suppressed by checking this option.

Controlling CTI Application

If a application uses the windows dialer, CTI Data Connector for Salesforce can be
configured to handle all requests that go to the windows dialer. This allows to use the call
logic for outgoing calls of CTI Data Connector for Salesforce .

Activate call logging

This configuration is intended for service purposes. It logs the events of the TAPI device
driver. See Troubleshooting - sending a log file how to send a log file  to support.

See also

Where do I find this screen?
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6.4.2 Help and Welcome

The following settings allow for configuring help options.

Help Type

2 different types of help is offered

Online Help - this is the most up-to-date help (updated even after program release). It is
recommended using this help
Offline Help - this help program is stored on the local hard disk drive and can be used, if
no Internet connection is available

 The offline help works with Windows XP SP2 / Vista only with a single user
installation
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Display Quick Introduction Help

Check this option to have the Welcome Screen displayed during each program start.

See also

Where do I find this screen?

 

6.4.3 Development API

These settings have an impact on the development API using the calls.xml and jobs.xml
file to handle phone events.

Always write XML file (calls.xml)

The default option specifies that a call is passed to an external program only after clicking
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on the Desktop Notification window. This option allows to always pass the caller data via
the calls.xml file independently from clicking on the Desktop Notification.

XML Character Set

The character set for the calls.xml and jobs.xml file can be changed. This is necessary in
order to pass caller data stored with different character set. Default is UTF-8.

Example
The address data is stored in the database with Greek characters. In order to pass the
address data it is necessary to change the default character set.

 The character set of the Desktop Notification cannot be changed.

Create calls.xml  only once per call
If checked, the calls.xml will be created only once per call. Otherwise the file will be
created for each TAPI event like ring, hold, terminate, provided that the user clicks once
on the Desktop Notification. See also: Always write XML file (calls.xml) .

Signal change in phone number

Using this option will signal in the calls.xml file, if the phone number has changed during
a call. This event can happen when a call is redirected. See also: Don’t signal updated
phone number during a call

Timeout during initializing a call transfer

This switch is used for the option Transfer a Call . It is the waiting time in seconds until
the PBX responds to the event. The default value is 5 seconds, maximum is 60 seconds.

See also

Where do I find this screen?
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6.4.4 Miscellaneous Settings

Terminate database connection after each call

If an Access database is used in an network environment and not all PCs shut down CTI
Data Connector for Salesforce during night, this database can never be backed up
because it is always in use. Use this option to allow for back-up or compression of an
database. 

 Depending on the usage of the database this option may significantly slow down the
performance.
     Never use this option on the server and never in combination with an SQL
database.
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Number of entries in Call History and Redialing list

Define the number of entries in the call history list.

Application to dial with Hyperlink

Defines the executable which is used by Windows callto: command - see  Dial with a
Hyperlink .

This command may be used by other applications like Skype. If CTI Data Connector for
Salesforce should use this functionality, disable in Skype: callto: links in other
applications. The default value for  CTI Data Connector for Salesforce  is dial.exe.

See also

Where do I find this screen?
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6.5 Configuration of the PBX and Caller Identification

This screen allows to specify PBX specific settings  and how to handle caller
identification .

See also

PBX Configuration
Dialing Rules
Dialing Rules for US / Canada
Configuration Caller Identification
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6.5.1 PBX Configuration

Basic Configuration settings for handling outgoing calls and PBX specific functions.

Dial tone digits for external calls

Specify the digit which is necessary to get an outside line for external calls, e.g. 0 or 9.
This prefix is added automatically for external calls. Also see dialing Rules  for extended
configuration.
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Minimum length of phone number indication an external call

For distinguishing between internal and external calls type in the maximum length of the
internal phone number + 1 (Example: The internal phone numbers are 0 to 99; an external
number would be defined by using 3 digits).

See also

Dialing Rules
Dialing Rules for US / Canada

6.5.1.1 Dialing Rules

With the button dialing Rules the country settings and area code settings can be
modified. It is important to configure the correct area code and country code.

Outside US / Canada it is sufficient to add the country/ region and the area code without
the leading 0. Never add a dialing rule because rules like prefixes are covered within CTI
Data Connector for Salesforce settings.

Example
Area Code: 425- never use 0425 for area code as 0 is part of the dialing rule which is
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automatically retrieved from the country settings.

For US / Canada see special considerations for dialing rules .

Outside US / Canada: Press the button Edit: Select your Country/Region and Area
Code without the leading 0 or 1. The fields Outside Line for local calls, long-distance calls,
carrier code for long-distance calls and international calls must be empty.

See also

Where do I find this screen?

 

6.5.1.2 Dialing Rules for US / Canada

As there are different dialing rules for local and long distance calls in the USA, these rules
have to be defined only within CTI Data Connector for Salesforce and NOT in the
Windows dialing rules.

Configuration within  CTI Data Connector for Salesforce

Set Dial tone digits for external calls  to 9
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Configuration within Windows

Press the button dialing Rules, or within Windows select Open Phone and Modem
Options by clicking the Start button, clicking Control Panel and then clicking Phone and
Modem Options.

TAB - General

Configure: Area code: 425; leave outside line empty 

TAB - Area Code rules 

In some places, some prefixes within an area code are considered local calls, and other
prefixes within the same area code are considered long distance. Use this tab to specify
those relationships and the rules for dialing those numbers.

In the New Area Code Rule dialog box, specify how certain phone numbers in the same or
other area codes need to be dialed. Include all the prefixes to be used for this area code.

Leave the field Dial empty 

Check: Include the area code.
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CTI Data Connector for Salesforce supports the dialing rules only if activated in the PBX
configuration screen.

See also

Where do I find this screen?

 

6.5.2 Configuration Caller Identification

 

Caller identification - truncate number of digits

CTI Data Connector for Salesforce can truncate a phone number until a phone number
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with a direct match is found.

Example
Incoming number: 0044734273833. This number is not associated with a contact person,
but the number of the main office with 0044734273-0 is stored. After 3 digits having been
truncated, the number of the main office will be found. If this logic is not needed, type in 0.
The default value is 3.

US or Canada
This option must be 0 because extensions can not be dialled directly.

Options
Complete database search in the defined sequence. If the phone number is NOT found
then the phone number is truncated and the search is done again in the same
database. If after truncating of the digits no caller ID is found, then the next database is
used to search for the phone number
After truncating a digit restart search in all databases. If the phone number is NOT
found, the phone number is searched in the next database. After searching in all
databases the phone number is truncated and the search starts with database 1 again

  This option is not used for salesforce

Don't show internal calls

If selected, the caller information for internal calls will not be displayed. For
distinguishing between internal and external calls, the value in the field Minimum length of
phone number indicating an external call will be used.

Use Called ID for caller identification

By default, the phone number of the person who is calling (CallerID) is used for caller
identification. If the number that was called (Called ID) is to be used, select this option.

Example

You provide a phone service for 10 companies and you offer a line for each company.
Whenever a phone comes in, the number that was called (line for company 1 to 10)
including the company name is to be displayed.

Suppress multiple hits due to identical phone numbers

If records are stored multiple times (the same phone number is stored multiple times),
CTI Data Connector for Salesforce  will always display multiple addresses and cannot
open a caller record or Outlook contact. If the option Suppress multiple hits due to
identical phone numbers is selected, always only one suitable record will be displayed.
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  This option is not used for salesforce

Display Caller ID identified by PBX

If your PBX has an own phone directory, CTI Data Connector for Salesforce can display
the name of the caller in the Desktop Notification passed by the PBX, if no address is
found in a database or Outlook.

The option: String if caller ID is suppressed should be the character string which is sent
by the PBX for suppressed caller IDs, e.g. ***. Instead of displaying *** the Desktop
Notification is not displayed.

  This option is not used for salesforce

Display Phone Number

Defines the format how the phone number is displayed in the call history or in the desktop
notification

Display number sent by TAPI driver without any change. The phone number is
formatted like in the display of the telephone set (depending on the TAPI driver) - e.g.
214.415.9160 
Display number in international format. The phone number is displayed in the
international format - 0012144159160 

See also

Where do I find this screen?
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7 Service Programmes

7.1 Show License Information

To display the license information, either

right click on the icon in the taskbar  - select Show License Information

or 

select within the Control Centre , Menu Extras, Show License Information

This will open the Licence Viewer where you can view the licenses you have acquired, the
number of users/computers who can use the licence and whether a licence has a time
limitation or not. 

Number of licenses

The folder CTI License displays the maximum number of licenses and the number of
licenses which are available. If you click on the + sign, all computers using a license will
be displayed. See Deactivate a License  how to deactivate one single computer. 

Number of Computers / PCs which have a license

Demoversion  - if omitted it is a full version or time-limited full version

Valid until (time limitation) - if omitted it is a non time-limited version

Web Activation  - either done or required

Update Subscription

The update subscription entitles you to install the latest updates as long as it has not
expired. See chapter software update  about how to download updates.

Available / Not available

Time limitation - the date when the update subscription expires

Release Number

Internal release information

23

25

167

164

134

11
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7.2 Apply Activation Key

An Activation Key is used to modify the license information (e.g. increase number of
licenses). All Activation Keys are unique and have the same format like: 

fZDdq-aDC95-e54DA-atR82-DL82k-NfC4v

There are 6 blocks each with 5 characters. The blocks are separated by a hyphen for
better readability. 

If you got an Activation Key via E-Mail or Fax, you can enter the key within the screen
Show License Information .

Start screen Show License Information

Select button Activation Key

Paste the key from the clipboard with CTRL+V

 It is possible to validate the Activation Key online. In this case an Internet connection
is necessary.
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7.3 Formatting of Phone Numbers

As the phone numbers stored in different formats in the enterprise databases cannot be
used for the caller identification, they have to be converted cyclically into an international
format.

This program normally runs on the server 1 or 2 times a day and formats all phone
numbers of all enterprise databases (profile databases). See Server Setup.

The local database (Quick dialing list and contact data from Microsoft Outlook™) and also
the main database in a single user environment has to be formatted on the local PC. This
is automatically done once a day after <%oemtitle%> has been started, if the option 
Refresh daily is selected. During the formatting of the phone numbers you can make
calls, but the caller identification will not be active.

Start the program for formatting the phone numbers by clicking on the icon in the taskbar
 with the right mouse button and select the option Format phone numbers or by

selecting the menu Extras - Format phone numbers in the control centre .

Depending on the installation some options might be disabled.
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 If you do not want to run the program every day, deselect Refresh daily and run the
program from time to time by pressing the button Start.

 A single user installation does not support formatting phone numbers on the server,
and all databases will have to be formatted locally.

7.4 Format Phone Numbers on the Server

This step has to be done on the server

A Server Setup is necessary to format  the phone numbers of enterprise databases.
When using Microsoft Outlook™ the formatting is done on the local PC.

The CTI Data Connector for Salesforce component has to be installed on the server with

the program SetupServer.exe. Start the program setupserver.exe on the  server
(never on the workstation). This installs all necessary components and creates a program
group CTI Data Connector for Salesforce with the entry CTI Data Connector for
Salesforce Format Phone Numbers. Start this program to format the phone numbers
manually in order to check if it is working.

You can start a cyclical formatting of phone numbers on the server. We recommend
doing this during the night. Ideally you use the Task manager of the server operating
system (Control Panel, Scheduled Tasks). To start the task use the following command:

cdcsfeSTARTER.EXE -R
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Alternatively you can use the timer function of CTI Data Connector for Salesforce. The
applications will reside in the memory of the server, while the memory is freed, if the
windows task manager is used.

Possible Parameters

-R: The program starts, formats the phone numbers and terminates
-Thh:mm: Starts as a "Server". The phone numbers are formatted at the specified time
(e.g.: -T08:00 = 8 o'clock)
-Mn: Starts as a "Server". The phone numbers are formatted after the specified time
interval (e.g.: M180 = 180 minutes)

See also

Network Installation - general information
Formatting of Phone Numbers

7.5 Error Protocol

In case of failing to access a database an error protocol will be written. You can display it
by clicking on the icon in the taskbar  with the right mouse button and selecting the
option Error protocol or selecting the menu Extras - error protocol in the control centre

.

The error protocol will be deleted with every start of CTI Data Connector for Salesforce.

There is a log file for error tracking with the TAPI device driver - see configuration settings
.

7.6 Phone Simulator

If you have no TAPI-enabled phone available and you want to test CTI Data Connector for
Salesforce, you can use the simulator which works like a regular telephone.

Activating the Simulator

Start the Configuration Wizard  and choose the page where you can select your
telephony service provider . Choose <Telephone Simulator>. When you start CTI
Data Connector for Salesforce, the simulator will be started automatically.
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Working with the Simulator

The telephone simulator acts like a normal telephone with which you can make outgoing
calls and accept incoming calls.

 

 

Type in phone
number

 

 

 Button for Dial,
Pick up, Hang up

 

 

 

 You can use the
keyboard to make
a call

Simulating an incoming call

Type in a phone number (without country code and special characters) in the display.
You can alternatively use the keyboard to type in the number.
Press the button Dial

CTI Data Connector for Salesforce performs the caller identification and signals the
incoming call
Accept the incoming call by pressing the button Pick up

You can disconnect the call by pressing the button Hang up

Simulating an outgoing call

Search in the phone book of CTI Data Connector for Salesforce for an address or a
contact person and dial by double-clicking on the phone number. You can dial
alternatively by highlighting a phone number  and pressing the configured Hotkey .
CTI Data Connector for Salesforce displays the dialled address

Establish the call by pressing the button Pick up

34 56
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You can disconnect the call by pressing the button Hang up
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8 Installation

CTI Data Connector for Salesforce supports single user  and network installation .
The network installation offers a centralized handling of the configuration settings, updates
and license information.  

A network installation is recommended with more then 3 PCs. 

Single User Installation

Network Installation

Activate Product

Installation FAQ

8.1 Browser Support

Browser Support

The following list of browsers are supported by salesforce.com for the call center adapter
4.0:

Minimum system requirements
IE8 +

Firefox 3.5 +

Chrome 10 +

Safari 4+

While the adapter supports IE8 and Firefox 3.5 performance is significantly improved in
browsers like

IE9

Firefox 5 and 6

Chrome 13

Safari 5

It is recommended that the call center adapter 4.0 is used with browsers in the above list.

 The limitations are due to the salesforce call center adapter 4.0. Check  with the
next salesforce release if new Browser versions are supported.

Internet Explorer warning message

If you are running Internet Explorer and receive warnings which say “Do you want to view
only the webpage content that was delivered securely when using the browser” - see

Warning mixed content . -
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8.2 Single User Installation

The installation consists of 5 steps:

Install call center adapter 4.0

Install the application on the local PC

Minimum Configuration Settings

Browser Support

Check SoftPhone

Activate Product

 
Each PC needs a Serial Number  to activate the software

By default, the icon is not visible on Vista and Windows 7 in the notification area. To show

the icon  for CTI Data Connector for Salesforce in the system tray, click on the up
arrow. Click on Customize.

This will open the Notification Area Icons control panel item. Select the icon for  CTI Data
Connector for Salesforce and in the pick list select: Show icon and notification.

Additionally add the red salesforce icon  
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8.2.1 Install Call Center Adapter

To install and activate the call center adapter the following steps are necessary.

1. System Requirements regarding Salesforce

To use the Call Center Adapter, the Professional, Enterprise, Developer or Unlimited
Edition is required. 

If you are using the Team Edition, contact Support@mirage-systems.de for an alternative
solution.

Important change in Version 4 - .NET Framework 3.5 is required. It is installed
automatically if missing.

System Requirements regarding PBX and operating system (it is imperative to check
before installation)

Telephone System

To communicate with a phone system, either a CTI server (Third Party Solution) or the
connection of the phone set to the PC (First Party Solution) is supported. For both
systems a TAPI driver 2.x (also referred to as TSP) is mandatory. See details for
TAPI - Where do I find the TAPI driver?

VOIP systems like Cisco Call Manager, Avaya, Swyx or Innovaphone normally have a
TAPI driver included. 
For Asterisk there are several vendors who offer a TAPI driver e.g. http://
www.xtelsio.com or http://activa.sourceforge.net.
If your VOIP / Cloud PBX system does not comes with a TAPI driver, try Global IP
Telecommunications Ltd (Ninja Pro) www.globalipphones.com . This software works
with all SIP compatible phone systems.
Traditional PBX systems like Siemens or Alcatel often require an additional TAPI
server.
ISDN phones without a PBX are available with an inbuilt TAPI driver. 

If you are using a modem, we strongly recommend switching to a phone set
connected to the PC (via USB/serial), because the TAPI drivers of modems often do
offer only basic functions or do not function at all. 

Please check firstly with your phone vendor about which solution meets your
requirements and how you can install and configure the TAPI driver. You can contact
Support@mirage-systems.de if you do have the TAPI driver installed and CTI Data
Connector for Salesforce has problems with making an outgoing call or receiving
incoming calls. 

Some TAPI drivers do not work on 64bit operating systems. You can use a virtual
machine with 32bit operating system. An example, how this is working is explained for 
MAC OS X.  For Windows Vista or Windows 7 64bit, the same virtual machines can

150
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http://www.xtelsio.com
http://www.xtelsio.com
http://activa.sourceforge.net 
http://www.globaliptel.com/eng/content/Content/Ninja/pro.html


88 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

be used.

Operating System

Windows XP SP3 to Windows 7 (32bit and 64 bit) is supported
.NET 3.5 is required for the salesforce call center adapter 4

Browser Support

The following list of browsers are supported by salesforce.com for the call center
adapter 4.0:

Minimum system requirements
IE8 +

Firefox 3.5 +

Chrome 10 +

Safari 4+

While the adapter supports IE8 and Firefox 3.5 performance is significantly improved in
browsers like

IE9

Firefox 5 and 6

Chrome 13

Safari 5

It is recommended that the call center adapter 4.0 is used with browsers in the above
list.

 The limitations are due to the salesforce call center adapter 4.0. Check  with the
next salesforce release if new Browser versions are supported.

Internet Explorer warning message

If you are running Internet Explorer and receive warnings which say “Do you want to
view only the webpage content that was delivered securely when using the browser” -

see Warning mixed content . -

Salesforce

The Salesforce Professional, Enterprise, Unlimited or Developer Edition is required for

154
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the call center functionality. If you are using the Team Edition, contact
Support@mirage-systems.de for an alternative solution.

See also

Configure  the TAPI driver within CTI Data Connector for Salesforce
Where do I find the TAPI driver?

2. Download the adapter 4.0 configuration file

Download the adapter (right mouse click, save target as) and save it on your hard disk.
There is a special USA / Canada and German adapter version. For all other countries use
the generic adapter.xml 

3. Add the configuration file to salesforce

Select: Setup > AppSetup > Customize > Call Center > Call Centers 

Click on the button: Import an select the file adapter.xml on your local hard disk

Browser for adapter.xml

CTI Data Connector - Call Center Adapter 4.0 will be added to the call center list

call center list

54

150

http://www.helpserver.biz/onlinehelp/cdc/sf/4.0/files/adapter-us.xml
http://www.helpserver.biz/onlinehelp/cdc/sf/4.0/files/adapter-german.xml
http://www.helpserver.biz/onlinehelp/cdc/sf/4.0/files/adapter.xml
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4. Configure the call center adapter

Click on the call center adapter. 

Note
If you make any changes of the configuration settings you have to logout in
salesforce, right click on the blue CTI Data Connector icon and select: Reload Salesforce
Configuration

Port

The Salesforce SoftPhone is a web application, which uses the port 11000. If this port is
used by another application contact Support@mirage-systems.de.

Dialing Options

The dialing options configuration depends on the PBX and on the country your are
located.

Configure call center
for USA

Configure call center for Europe or other countries

Outside Prefix - (number to access an outside line) - e.g. in US   91 407-398-6913 or in
Europe it is often 0 031976354 

Long Distance Prefix - Carrier Code to make a long distance call - e.g in US  1 407-398-
6913, in Europe it is often 0 e.g. 031976354

International Prefix - Carrier Code to make an international call - e.g. in US
011497525529339 to make a call to Germany, in Europe it is often 00 e.g.
00497525529339

Country Code - Country code of your country - e.g US is 1, Germany 49. Click here for
a list of all country codes

http://countrycode.org/
http://countrycode.org/
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You have to use an own adapter  for each country where you have call center users.

Save call as a task

Each call (incoming and outgoing) can be automatically saved as a task / activity
including the call duration and a phone note. 

Subject of the task - configure the subject line. Either use a text like CALL or one of the
following variables

{calltype} - inserts either Incoming Call or Outgoing Call
{time} - inserts the time
{date} - inserts the current date

Autosave incoming calls: Y = Yes, N = No. Define if an incoming call should be
automatically saved.  If you type in a phone note the call is always saved
Autosave outgoing calls: Y = Yes, N = No. Define if an outgoing call should be
automatically saved.  If you type in a phone note the call is always saved
Autosave unsuccessful calls: Y = Yes, N = No . Define if an unsuccessful call = call
duration with 0 seconds should be stored. If you type in a phone note the call is always
saved

Call-Wrap-Up 

To rate a phone call, you can activate the Call Wrap Up feature, which  is displayed at the
end of the phone call in the SoftPhone .

Details how to configure it

94
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Expert Settings
Changes are only necessary in case there are problems with the adapter.

Details how to configure it

5. Add users to the call center

Now click on the button: Manage Call Center Users

add call center users

Add the users who should use CTI Data Connector for Salesforce

  
If the user is not listed, he is probably assigned to another call center adapter. You have to
remove the user from this adapter because one user cannot be assigned to multiple
adapters at the same time.

6. Configure Softphone Layout

General Settings

The salesforce administrator can configure the user interface of the SoftPhone with the
menu option: Softphone-Layouts .  It allows you e.g. to define which fields should
appear on the SoftPhone or general settings for the display of the call.The settings are
valid for all users.

 Not all functions, which can be configured here, are supported by CTI Data
Connector for Salesforce.

User specific settings

Each user can configure Personal settings:  Setup > Personal Setup > Call Center
Settings > My Softphone Settings

97
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7. Configure Task Page layout

All phone calls are saved as a task. To make some special phone fields like call duration
accessible for the user, they can be added to the task page layout.
Select: Setup > Customize > Activities > Task Page Layouts.

Add the fields:

Call Type

Call Result

Call Duration

Troubleshooting

If you are running Internet Explorer and receive warnings which say “Do you want to view
only the webpage content that was delivered securely when using the browser” - see
Warning mixed content .

For all other errors browse the chapter:  Error - Call Center Adapter

Salesforce offers a web page with comprehensive information and questions and
answers 

For more information about the salesforce call center adapter search in the salesforce
online help using the search term: call center adapter overview

The integration in salesforce requires one of the following salesforce editions:  
Professional, Enterprise, Unlimited oder Developer Edition.
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http://wiki.developerforce.com/page/Troubleshooting_Your_CTI_Adapter#Is_there_a_wrap-up_timer.2C_or_can_I_add_one.3F
http://wiki.developerforce.com/page/Troubleshooting_Your_CTI_Adapter#Is_there_a_wrap-up_timer.2C_or_can_I_add_one.3F
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8.2.1.1 Install Multiple Call Center Adapters

If you want to have different options depending on user groups (e.g. sales and
support or you have locations in different countries), you can install multiple Call Center
Adapters.

The same applies to languages. The standard fields are automatically displayed in the
user language. If you need to translate the custom fields, e.g. in the Call Wrap Up ,
just make an own adapter for each language.

Rename the adapter

Click on edit and rename the fields: Internal Name and Display Name.

Import a new adapter

Import a new adapter  and make different settings.

8.2.1.2 Call Wrap Up / Call Results

To rate a phone call, you can activate the Call Wrap Up feature, which  is displayed at the
end of the phone call in the SoftPhone .

The options, which are available to rate a phone call or add a call result, can be defined
with Label 1 to 10. 

91
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This is how it will appear on the softphone.
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The selected item is saved with the note as an activity using the text, which is defined
as: value for report. You can either use the same text for the report as the label or use
another value.

Example:
Label: Send Quote - Value for Report: Send Quote. The text Send Quote is saved for the
report.
Label: Send Quote - Value for Report: CODE-SQ. The text CODE-SQ is saved for the
report.

A different value for the report e.g. makes sense, if you configure adapters in different
languages but you want to have the same result text in the report.

See also: Reports

  
If you want to update fields depending on a phone call, create a workflow within salesforce
and use the 3 call specific fields (Call Type, Call Result, Call Duration) described in step 6

 to trigger the workflow.

If you want to have different options depending on user groups (e.g. sales and
support or you have locations in different countries) you can install multiple Call Center
Adapters .

48
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Activity History

A good idea is to add the call wrap up code in the activity history view. One glimpse and
you are informed about the result of the last call.

8.2.1.3 Expert Settings

Changes are only necessary in case there are problems with the adapter.

Polling interval in salesforce adapter

Change this value if you get calls signaled in the SoftPhone with a large delay. The
smaller this value, the faster events are handled within the SoftPhone.

Timeout for http requests

In case the SoftPhone does not react after some time and this happens frequently, then
change this value to 50.000 to 1000.000

8.2.1.4 Softphone Layout

Configure Layout

You can define, which fields should be displayed on the SoftPhone. This definition can be
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done with different settings for internal, inbound and outbound calls. You can not only
display the name of the caller but also information like VIP status, turnover, service level
agreement, language or other information.

Select: Setup > AppSetup > Customize > Call Center > SoftPhone Layouts

Cases

If you want to work with cases and assign a call to a case, you have to add the Case
object for incoming and outgoing calls in the SoftPhone Layout.

Configure Cases - Step 1

Click on: Add / Remove Objects and select the Case object. Then ensure that the Case
Number is displayed in the SoftPhone.
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Configure Cases - Step 2

Internal Calls

To configure internal calls, you have to define the length of internal phone numbers in the
configuration wizard

Within the SoftPhone Layout, select the call type: Internal

The next step is to assign the object, which should be used for the search. Select: User

The search within users will work for the fields Phone and Extension, but not for the field
Mobile. Although it is possible to search in contacts, the search will provide wrong results
- e.g. extension 212 calls and this would find an address with the phone number 
212.827.1991  

The calls are saved as an activity with the call type: Internal Call

69
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Configure internal calls

8.2.2 Install the application on the local PC

You can select during the installation whether you want to install a Single User or Multi
User system. Select Single User System.
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Necessary Rights

During installation DLLs are registered. The user who installs the application needs a right
to register DLLs.

The user who runs the application needs the following rights on the installation folder:

Files cdcsfe.xml and cdcsfe.lic: read and write access

All other files: read access

See also

Single User Installation - general information

8.2.3 Minimum Configuration Settings

During installation, the Configuration Wizard  was already started. You can define a lot
of individual configuration settings there. The following settings have to be defined to
guarantee a basic functionality.

TAPI device driver  - it is delivered by the telephone manufacturer. See also: System
requirements - TAPI driver  . If you don't have a TAPI driver yet, you can use the
Telephone Simulator  for testing.
Button Dialing Rules  - configures country settings and area code. See also special
configuration for US / Canada

Just by setting this minimum configuration you will be able to make outgoing calls and to
identify incoming calls. The Configuration Wizard can be started any time by right click
on the icon , option Configuration Wizard .
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See also

Where do I find the TAPI driver?
System requirements - TAPI driver

 
 

8.2.4 Check SoftPhone

After login in Salesforce you should see the Salesforce SoftPhone at the left upper corner
of the browser. The SoftPhone is only available on the main screens like Home, Lead,
Account, Contact or Cases but not in screens like Setup.
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Using the service cloud , the SoftPhone appears at the bottom right corner. 

Service Cloud Console - Main Screen

Internet Explorer

If you are running Internet Explorer you probably receive the following warning 
Do you want to view only the web content that was delivered securely? (Warning mixed
content)

45
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The warning can be disabled using the following steps:

Go to Tools -> Internet Options -> Security -> Local Intranet

Click "Custom Level"

Select "Enable" for "Display mixed content"
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Click "OK"

Click "OK"

SoftPhone is not loading

For all other errors browse the chapter:  Error - Call Center Adapter

Quick Test

Test with a mobile phone (the caller ID must be transmitted)

Incoming calls

Outgoing calls
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8.3 Network Installation

Perform the following steps for network installation.

Install call center adapter 4.0

Copy all files to the server

Workstation Setup

Browser Support

Check SoftPhone

Distribute Client Setup to all PCs

Activate Product

 The network installation can be started from any workstation. 

 
Only one Serial Number is needed. The Serial Number includes the number of PCs
which can be installed.

By default, the icon is not visible on Vista and Windows 7 in the notification area. To show

the icon  for CTI Data Connector for Salesforce in the system tray, click on the up
arrow. Click on Customize.

This will open the Notification Area Icons control panel item. Select the icon for  CTI Data
Connector for Salesforce and in the pick list select: Show icon and notification.
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Additionally add the red salesforce icon  

8.3.1 Install Call Center Adapter

To install and activate the call center adapter the following steps are necessary.

1. System Requirements regarding Salesforce

To use the Call Center Adapter, the Professional, Enterprise, Developer or Unlimited
Edition is required. 

If you are using the Team Edition, contact Support@mirage-systems.de for an alternative
solution.

Important change in Version 4 - .NET Framework 3.5 is required. It is installed
automatically if missing.

System Requirements regarding PBX and operating system (it is imperative to check
before installation)

Telephone System

To communicate with a phone system, either a CTI server (Third Party Solution) or the
connection of the phone set to the PC (First Party Solution) is supported. For both
systems a TAPI driver 2.x (also referred to as TSP) is mandatory. See details for
TAPI - Where do I find the TAPI driver?

VOIP systems like Cisco Call Manager, Avaya, Swyx or Innovaphone normally have a
TAPI driver included. 
For Asterisk there are several vendors who offer a TAPI driver e.g. http://
www.xtelsio.com or http://activa.sourceforge.net.
If your VOIP / Cloud PBX system does not comes with a TAPI driver, try Global IP
Telecommunications Ltd (Ninja Pro) www.globalipphones.com . This software works
with all SIP compatible phone systems.
Traditional PBX systems like Siemens or Alcatel often require an additional TAPI
server.
ISDN phones without a PBX are available with an inbuilt TAPI driver. 

If you are using a modem, we strongly recommend switching to a phone set
connected to the PC (via USB/serial), because the TAPI drivers of modems often do
offer only basic functions or do not function at all. 

Please check firstly with your phone vendor about which solution meets your
requirements and how you can install and configure the TAPI driver. You can contact
Support@mirage-systems.de if you do have the TAPI driver installed and CTI Data
Connector for Salesforce has problems with making an outgoing call or receiving
incoming calls. 

150

http://www.xtelsio.com
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http://www.globaliptel.com/eng/content/Content/Ninja/pro.html
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Some TAPI drivers do not work on 64bit operating systems. You can use a virtual
machine with 32bit operating system. An example, how this is working is explained for 
MAC OS X.  For Windows Vista or Windows 7 64bit, the same virtual machines can
be used.

Operating System

Windows XP SP3 to Windows 7 (32bit and 64 bit) is supported
.NET 3.5 is required for the salesforce call center adapter 4

Browser Support

The following list of browsers are supported by salesforce.com for the call center
adapter 4.0:

Minimum system requirements
IE8 +

Firefox 3.5 +

Chrome 10 +

Safari 4+

While the adapter supports IE8 and Firefox 3.5 performance is significantly improved in
browsers like

IE9

Firefox 5 and 6

Chrome 13

Safari 5

It is recommended that the call center adapter 4.0 is used with browsers in the above
list.

 The limitations are due to the salesforce call center adapter 4.0. Check  with the
next salesforce release if new Browser versions are supported.

Internet Explorer warning message

If you are running Internet Explorer and receive warnings which say “Do you want to
view only the webpage content that was delivered securely when using the browser” -

see Warning mixed content . -
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Salesforce

The Salesforce Professional, Enterprise, Unlimited or Developer Edition is required for
the call center functionality. If you are using the Team Edition, contact
Support@mirage-systems.de for an alternative solution.

See also

Configure  the TAPI driver within CTI Data Connector for Salesforce
Where do I find the TAPI driver?

2. Download the adapter 4.0 configuration file

Download the adapter (right mouse click, save target as) and save it on your hard disk.
There is a special USA / Canada and German adapter version. For all other countries use
the generic adapter.xml 

3. Add the configuration file to salesforce

Select: Setup > AppSetup > Customize > Call Center > Call Centers 

Click on the button: Import an select the file adapter.xml on your local hard disk

Browser for adapter.xml

CTI Data Connector - Call Center Adapter 4.0 will be added to the call center list

54
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http://www.helpserver.biz/onlinehelp/cdc/sf/4.0/files/adapter-us.xml
http://www.helpserver.biz/onlinehelp/cdc/sf/4.0/files/adapter-german.xml
http://www.helpserver.biz/onlinehelp/cdc/sf/4.0/files/adapter.xml
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call center list

4. Configure the call center adapter

Click on the call center adapter. 

Note
If you make any changes of the configuration settings you have to logout in
salesforce, right click on the blue CTI Data Connector icon and select: Reload Salesforce
Configuration

Port

The Salesforce SoftPhone is a web application, which uses the port 11000. If this port is
used by another application contact Support@mirage-systems.de.

Dialing Options

The dialing options configuration depends on the PBX and on the country your are
located.

Configure call center
for USA

Configure call center for Europe or other countries

Outside Prefix - (number to access an outside line) - e.g. in US   91 407-398-6913 or in
Europe it is often 0 031976354 

Long Distance Prefix - Carrier Code to make a long distance call - e.g in US  1 407-398-
6913, in Europe it is often 0 e.g. 031976354
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International Prefix - Carrier Code to make an international call - e.g. in US
011497525529339 to make a call to Germany, in Europe it is often 00 e.g.
00497525529339

Country Code - Country code of your country - e.g US is 1, Germany 49. Click here for
a list of all country codes

 
You have to use an own adapter  for each country where you have call center users.

Save call as a task

Each call (incoming and outgoing) can be automatically saved as a task / activity
including the call duration and a phone note. 

Subject of the task - configure the subject line. Either use a text like CALL or one of the
following variables

{calltype} - inserts either Incoming Call or Outgoing Call
{time} - inserts the time
{date} - inserts the current date

Autosave incoming calls: Y = Yes, N = No. Define if an incoming call should be
automatically saved.  If you type in a phone note the call is always saved
Autosave outgoing calls: Y = Yes, N = No. Define if an outgoing call should be
automatically saved.  If you type in a phone note the call is always saved
Autosave unsuccessful calls: Y = Yes, N = No . Define if an unsuccessful call = call
duration with 0 seconds should be stored. If you type in a phone note the call is always
saved

94
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http://countrycode.org/
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Call-Wrap-Up 

To rate a phone call, you can activate the Call Wrap Up feature, which  is displayed at the
end of the phone call in the SoftPhone .

Details how to configure it

Expert Settings
Changes are only necessary in case there are problems with the adapter.

Details how to configure it

5. Add users to the call center

Now click on the button: Manage Call Center Users

add call center users

Add the users who should use CTI Data Connector for Salesforce

  
If the user is not listed, he is probably assigned to another call center adapter. You have to
remove the user from this adapter because one user cannot be assigned to multiple
adapters at the same time.

6. Configure Softphone Layout

General Settings

The salesforce administrator can configure the user interface of the SoftPhone with the
menu option: Softphone-Layouts .  It allows you e.g. to define which fields should
appear on the SoftPhone or general settings for the display of the call.The settings are
valid for all users.
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 Not all functions, which can be configured here, are supported by CTI Data
Connector for Salesforce.

User specific settings

Each user can configure Personal settings:  Setup > Personal Setup > Call Center
Settings > My Softphone Settings

7. Configure Task Page layout

All phone calls are saved as a task. To make some special phone fields like call duration
accessible for the user, they can be added to the task page layout.
Select: Setup > Customize > Activities > Task Page Layouts.

Add the fields:

Call Type

Call Result

Call Duration

Troubleshooting

If you are running Internet Explorer and receive warnings which say “Do you want to view
only the webpage content that was delivered securely when using the browser” - see
Warning mixed content .

For all other errors browse the chapter:  Error - Call Center Adapter

154
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Salesforce offers a web page with comprehensive information and questions and
answers 

For more information about the salesforce call center adapter search in the salesforce
online help using the search term: call center adapter overview

The integration in salesforce requires one of the following salesforce editions:  
Professional, Enterprise, Unlimited oder Developer Edition.

8.3.1.1 Install Multiple Call Center Adapters

If you want to have different options depending on user groups (e.g. sales and
support or you have locations in different countries), you can install multiple Call Center
Adapters.

The same applies to languages. The standard fields are automatically displayed in the
user language. If you need to translate the custom fields, e.g. in the Call Wrap Up ,
just make an own adapter for each language.

Rename the adapter

Click on edit and rename the fields: Internal Name and Display Name.

Import a new adapter

Import a new adapter  and make different settings.

8.3.1.2 Call Wrap Up / Call Results

To rate a phone call, you can activate the Call Wrap Up feature, which  is displayed at the
end of the phone call in the SoftPhone .

The options, which are available to rate a phone call or add a call result, can be defined
with Label 1 to 10. 
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http://wiki.developerforce.com/page/Troubleshooting_Your_CTI_Adapter#Is_there_a_wrap-up_timer.2C_or_can_I_add_one.3F
http://wiki.developerforce.com/page/Troubleshooting_Your_CTI_Adapter#Is_there_a_wrap-up_timer.2C_or_can_I_add_one.3F
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This is how it will appear on the softphone.
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The selected item is saved with the note as an activity using the text, which is defined
as: value for report. You can either use the same text for the report as the label or use
another value.

Example:
Label: Send Quote - Value for Report: Send Quote. The text Send Quote is saved for the
report.
Label: Send Quote - Value for Report: CODE-SQ. The text CODE-SQ is saved for the
report.

A different value for the report e.g. makes sense, if you configure adapters in different
languages but you want to have the same result text in the report.

See also: Reports

  
If you want to update fields depending on a phone call, create a workflow within salesforce
and use the 3 call specific fields (Call Type, Call Result, Call Duration) described in step 6

 to trigger the workflow.

If you want to have different options depending on user groups (e.g. sales and
support or you have locations in different countries) you can install multiple Call Center
Adapters .
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Activity History

A good idea is to add the call wrap up code in the activity history view. One glimpse and
you are informed about the result of the last call.

8.3.1.3 Expert Settings

Changes are only necessary in case there are problems with the adapter.

Polling interval in salesforce adapter

Change this value if you get calls signaled in the SoftPhone with a large delay. The
smaller this value, the faster events are handled within the SoftPhone.

Timeout for http requests

In case the SoftPhone does not react after some time and this happens frequently, then
change this value to 50.000 to 1000.000

8.3.1.4 Softphone Layout

Configure Layout

You can define, which fields should be displayed on the SoftPhone. This definition can be
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done with different settings for internal, inbound and outbound calls. You can not only
display the name of the caller but also information like VIP status, turnover, service level
agreement, language or other information.

Select: Setup > AppSetup > Customize > Call Center > SoftPhone Layouts

Cases

If you want to work with cases and assign a call to a case, you have to add the Case
object for incoming and outgoing calls in the SoftPhone Layout.

Configure Cases - Step 1

Click on: Add / Remove Objects and select the Case object. Then ensure that the Case
Number is displayed in the SoftPhone.
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Configure Cases - Step 2

Internal Calls

To configure internal calls, you have to define the length of internal phone numbers in the
configuration wizard

Within the SoftPhone Layout, select the call type: Internal

The next step is to assign the object, which should be used for the search. Select: User

The search within users will work for the fields Phone and Extension, but not for the field
Mobile. Although it is possible to search in contacts, the search will provide wrong results
- e.g. extension 212 calls and this would find an address with the phone number 
212.827.1991  

The calls are saved as an activity with the call type: Internal Call

69
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Configure internal calls

8.3.2 Copy all files to the server

Start the installation on the workstation and not on the server. The installation
just copies files to the server.

You can select during the installation whether you want to install a Single User or Multi
User system. Select Multi User System to for a network installation.

The setup just copies the files to the server. This allows having all files installed on one
folder. Each workstation uses these files. 

The installation can be started from any workstation.
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 You have to give full read and write access for all users to the installation folder.

See also

Network Installation - general information

8.3.3 Workstation Setup

To install a workstation (client PC) perform the following steps:

Open the file explorer on your Workstation

Open the installation folder on the server - default folder is ...programs\CTI Data
Connector for Salesforce
Start Setup.exe on your Workstation

Make the Minimum Configuration Settings  - use the button Help to get detail
information about the configuration options

All settings which have been defined by the administrator are automatically applied. For

106
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details see: Distribute Client Setup.

Necessary Rights

During installation DLLs are registered. The user who installs the application needs a right
to register DLLs.

The user who runs the application needs the following rights on the installation folder on
the server:

Files cdcsfe.xml and cdcsfe.lic: read and write access

All other files: read access

  Each PC (not user) needs a CTI license .

Browser

In case Internet Explorer is used, you should push the the necessary settings through a
group policy to all users. See Internet Explorer.

Silent Setup

CTI Data Connector for Salesforce supports a silent setup without any user interaction.
Only at the end of the setup the user has to select his TAPI device driver. If Microsoft
.NET needs to be installed, there will always be a license agreement dialog, which has to
be confirmed.

Start the silent setup with: setup.exe /exenoui INSTALLTYPE="/S"

164
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Icon in the System Tray

By default, the icon is not visible on Vista and Windows 7 in the notification area. To show

the icon  for CTI Data Connector for Salesforce in the system tray, click on the up
arrow. Click on Customize.

This will open the Notification Area Icons control panel item. Select the icon for  CTI Data
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Connector for Salesforce and in the pick list select: Show icon and notification.

Additionally add the red salesforce icon  

See also

Network Installation - general information

8.3.4 Check Softphone

After login in Salesforce you should see the Salesforce SoftPhone at the left upper corner
of the browser. The SoftPhone is only available on the main screens like Home, Lead,
Account, Contact or Cases but not in screens like Setup.

Using the service cloud , the SoftPhone appears at the bottom right corner. 

106
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Service Cloud Console - Main Screen

Internet Explorer

If you are running Internet Explorer you probably receive the following warning 
Do you want to view only the web content that was delivered securely? (Warning mixed
content)

The warning can be disabled using the following steps:

Go to Tools -> Internet Options -> Security -> Local Intranet
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Click "Custom Level"

Select "Enable" for "Display mixed content"
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Click "OK"

Click "OK"

SoftPhone is not loading

For all other errors browse the chapter:  Error - Call Center Adapter

Quick Test

Test with a mobile phone (the caller ID must be transmitted)

Incoming calls

Outgoing calls

153
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8.4 Terminal Server

Terminal Server installation is not supported with version 4. Install version 3 instead. We
are working on a solution for this problem.

First check, if your TAPI server is approved for Terminal Server usage. You then do not
need additional licenses for CTI Data Connector for Salesforce. If the TAPI driver is
installed on the local PC (telephone handset is directly connected to the PC) and CTI
Data Connector for Salesforce is running on the Terminal Server, then the Terminal
Server Server Add-On for CTI Data Connector for Salesforce is necessary. This allows
the local TAPI driver to communicate with the application on the Terminal Server.

Installation with TAPI driver installed on Terminal Server 

If the TAPI server is Terminal server approved the installation is done as follows

Start the installer package through the control panel

Proceed as explained in the network installation  chapter

During the Workstation Setup , select in the program manager dialogue: Install CTI

Data Connector for Salesforce  for all users. 

If there are multiple Terminal Servers, start the workstation setup  on each server.

Every user can select a TAPI driver when he runs CTI Data Connector for Salesforce.
There should be a list with multiple extensions listed in the TAPI driver  selection.

Installation with TAPI driver installed on the local PC (Terminal
Server Add-On required)

Some TAPI drivers don't work on a Terminal Server (e.g. there is no 64bit TAPI driver or
the driver is not Terminal Server compliant). Having this situation you can install the TAPI
driver on the local PC. The installation process requires an additional setup and the
license for the Terminal Server Add-On.

Install files on the Terminal Server

Install files on the local PC

 A Citrix Server Add-On will be available shortly. Please contact Support@mirage-
systems.de for more information.
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8.4.1 Install files on Terminal Server

Step 1

Install CTI Data Connector for Salesforce on the Terminal Server

Start the installer package through the control panel

Run the Network Installation

During the Workstation Setup  select the TAPI driver <Terminal Server Installation
>. 

The next step is to install additional files on the Terminal Server.

Apply the Activation Key  you got when buying the Terminal Server Add-On

Copy the file ts-serverinstall.exe to the installation directory of CTI Data Connector for
Salesforce on the Terminal Server
Start the file ts-serverinstall.exe. It just copies some files on the server

Now continue with Step 2 - Install files on the local PC

130
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8.4.1.1 Start installer package

To install an application on the Terminal Server you have to start the installer through the 
control panel. Just follow follow the steps below to start the installer.

Start installer

Step 1
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Step 2

Select the  Installer package of CTI Data Connector for Salesforce - the name of the package can
be different per product and version
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8.4.2 Install files on the local PC

Step 2

Each PC, needs a small component of CTI Data Connector for Salesforce, which
communicates with the Terminal Server.

Install the TAPI driver from the phone set

From the installation directory on the server, start the file ts-clientinstall.exe 

It installs the necessary files. At the end of the installation you have to configure the
TAPI driver.

On the next screen only select your TAPI driver and leave the other settings on their
default values.
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 You have to reboot after the installation to initialize the connection to the Terminal
Server.

Windows 64bit Client

If the client PC uses Windows 64bit you have to use the 32bit mstsc.exe.

First rename the 64-bit mstsc.exe from System32 to prevent it from replacing the 32-bit
process. This is simple if you have rights to rename that file. If you’re on NTFS you may
get a “You require permission from Trusted Installer to make changes to this file” error.

To solve this error, you need to take Ownership of the file and give yourself full
permissions:

Browse to %SystemRoot%\System32

Right click mstsc.exe and choose Properties

Go to the Security tab

Click Advanced
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Go to the Owner tab

Click Edit

From the “Change owner to:” list, choose your user name

Click OK

Go to the Permissions tab

Click Change Permissions…

Click Add

Enter your user name and click OK

Tick the box in the Allow column for Full control

Click OK

Click OK

A Windows Security warning will come up; click Yes to proceed

Click OK

Now, you can rename the file mstsc.exe to something like mstsc.exe.old or
mstsc.exe.bak

Then, you can launch mstsc.exe from %SystemRoot%\SysWOW64 and you will have 32-
bit Remote Desktop Connection running.  Make a shortcut of the 32 Bit mstsc.exe to your
desktop or Pin it to your start menu.

See also

Where do I find the TAPI driver?
System requirements - TAPI driver

 

8.5 Activate Product

During the trial period, the activation screen appears with each start of the program. You
need a Serial Number for activating the product - see Buy Serial Number .

You do not have to reinstall the version and you can directly activate it if: 

You have installed the trial version as a single user version and you bought a single user
version
You have installed the trial version as a network version and you bought a network
version

and

The version you have installed has the same version number like the version you
bought - see How can I check my version number?
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 Always activate the software on a workstation and never on the server.

What happens during activation?

The activation process will connect the licence to the PC or Server. Use the Serial
Number only on the PC / Server you want to use CTI Data Connector for
Salesforce. The Serial Number cannot be used twice. After the activation is done, CTI
Data Connector for Salesforce will run only on this PC / Server. Your hardware data,
Serial Number, name, e-mail address and some program-specific data is transferred to
our activation center. No other data stored on your PC will be transmitted.

 The activation process can be done from any PC, even if you have a network
version (starting the activation process on the server is not possible)

Select Activation Method

On the first screen select: I have a Serial Number and I want to activate CTI Data
Connector for Salesforce. This will give you a selection how to activate the product.  The
Online Activation  is the recommended activation method and should be used if an
Internet connection is available. E-Mail Activation  can be used in case the online
activation is blocked.

(note: the screen you see could be slightly different)

138
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Message - Serial Number required

If you get the message, that a Serial Number is required, press the button Next and
select between online  and e-mail activation . A Serial Number is required. Without
a Serial Number the application can only be terminated using the End button.

138 140
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 Start Video Tutorial for product Activation

See also

Buy Serial Number
Online Activation
E-Mail Activation
Reinstall Software
Your CTI Data Connector for Salesforce License

8.5.1 Buy Serial Number

The Serial Number is your proof of purchase. It is unique and will look like this: 

dO8uc-G1iC9-jOGeA-BqgEX-U71lD-0V1VX

137

138
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http://www.helpserver.biz/onlinehelp/cdc/tutorial/2.4/activation/product-activation-tutorial.htm
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There are 6 blocks each with 5 characters. The blocks are separated by a hyphen for
better readability. 
For a network version, the Serial Number also includes the number of network licenses.

Buy Serial Number

If you do not have a valid serial number, click on the Link Buy a Serial Number online

Activate CTI Data Connector for Salesforce

Activate the product Online  or by E-Mail .

8.5.2 Online Activation

The Online Activation needs the Serial Number , company name, your name, country 
and your e-mail address.. Press the button Next. Then the licence will be verified online
and activated.  If the Activation is successful, the screen Activation finished  is
displayed.

No additional step will be required. CTI Data Connector for Salesforce can now be used
on this PC / Server.

 Backup your Serial Number. You will need it for a reinstallation.

138 140
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8.5.3 E-Mail Activation

The E-Mail Activation needs the Serial Number , company name, your name, country 
and your e-mail address. 

E-Mail Activation

Request Unlock Key

After filling out the screen, select: Request Unlock Key by E-Mail - send E-Mail. This
will open your default E-Mail client. An e-mail with the hardware IDs and licence
information will be created. Press send to send the e-mail to our activation center. You
will get an Unlock Key back within 2-3 business days.

137
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E-Mail Activation - send E-Mail

In case your e-mail client does not open or you use a Browser based e-mail, you can
open your e-mail and copy the content with CTRL+V. The e-mail address to send the e-
mail is displayed on the next screen.
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Enter Unlock Key

After requesting the Unlock Key by fax, the screen shown below will appear during each
start of the program. Type in the Unlock Key you got back by e-mail or fax. Press the
button Next. If the Activation is successful, the screen Activation finished  is displayed.

Enter Unlock Key

 Backup your Serial Number. You will need it for a reinstallation .

143
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8.5.4 Activation finished

Either after the Online Activation  screen or after entering the Unlock Key , the final
screen appears to signal that the activation was successful. Press the button Next to
complete the activation process to get the screen Activation finished.

If you got additional keys, e.g. for an update subscription, you can copy and paste the
keys now.

8.5.5 Reinstall Software

You can reinstall the application on the same PC / Server as often as you like. First
uninstall CTI Data Connector for Salesforce, delete the  complete installation folder,
then reinstall the application - see How do I activate CTI Data Connector for Salesforce?

138 142
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See also

Installation

8.6 Install an update

To install the latest update.

8.7 Transfer license / Move to another computer

You can move the license to a new computer (single user installation) or new server
(network installation). The license will be deactivated on the current computer / server.
The Serial Number can then be used again on another computer / server to activate the
product.

This process requires an online connection. You only can transfer a license for a full
version (no demo version).

Note

The functionality is available within a network installation only if the application is started
with cdcsfe -admin to prevent, that the license is transferred accidentally. A single PC
within a network can be always deactivated without an online connection - see Deactivate
a PC within a network .

Step 1 - Show License Viewer

Blue icon , right mouse click -  Show License Information

Step 2 - Transfer License

Click on the button Transfer License
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Button - Transfer License

Thereafter an information is displayed, that the license will be deactivated



146 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

Screen - License Deactivation

Step 3 - Activate CTI Data Connector for Salesforce on a new
computer

You can reuse the Serial Number on a new computer to activate CTI Data Connector for
Salesforce 

 

After the license was deactivated, you can reactivate it during the next program start as
long as the Serial Number was not used on another computer
The license can be transferred multiple times between computers - Example: Transfer
license from PC A to PC B. Then deactivate on PC B and activate again on PC A
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8.8 Installation FAQ

This chapter introduces Frequently Asked Questions around the installation process.

System Requirements - TAPI driver

Where do I find the TAPI driver?

How do I activate CTI Data Connector for Salesforce?

8.8.1 System Requirements - Operating system

Windows XP to Windows 7 (32bit and 64 bit) is supported
.NET Framework  3.5 is required for the salesforce call center adapter 4

Browser Support

The following list of browsers are supported by salesforce.com for the call center adapter
4.0:

Minimum system requirements
IE8 +

Firefox 3.5 +

Chrome 10 +

Safari 4+

While the adapter supports IE8 and Firefox 3.5 performance is significantly improved in
browsers like

IE9

Firefox 5 and 6

Chrome 13

Safari 5

It is recommended that the call center adapter 4.0 is used with browsers in the above list.

 The limitations are due to the salesforce call center adapter 4.0. Check  with the
next salesforce release if new Browser versions are supported.

Internet Explorer warning message

If you are running Internet Explorer and receive warnings which say “Do you want to view
only the webpage content that was delivered securely when using the browser” - see

Warning mixed content . -

148
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8.8.2 System Requirements - TAPI driver

Telephone System

To communicate with a phone system, either a CTI server (Third Party Solution) or the
connection of the phone set to the PC (First Party Solution) is supported. For both
systems a TAPI driver 2.x (also referred to as TSP) is mandatory. See details for TAPI
- Where do I find the TAPI driver?

VOIP systems like Cisco Call Manager, Avaya, Swyx or Innovaphone normally have a
TAPI driver included. 
For Asterisk there are several vendors who offer a TAPI driver e.g. http://
www.xtelsio.com or http://activa.sourceforge.net.
If your VOIP / Cloud PBX system does not comes with a TAPI driver, try Global IP
Telecommunications Ltd (Ninja Pro) www.globalipphones.com . This software works
with all SIP compatible phone systems.
Traditional PBX systems like Siemens or Alcatel often require an additional TAPI server.

ISDN phones without a PBX are available with an inbuilt TAPI driver. 

If you are using a modem, we strongly recommend switching to a phone set connected
to the PC (via USB/serial), because the TAPI drivers of modems often do offer only
basic functions or do not function at all. 

Please check firstly with your phone vendor about which solution meets your
requirements and how you can install and configure the TAPI driver. You can contact
Support@mirage-systems.de if you do have the TAPI driver installed and CTI Data
Connector for Salesforce has problems with making an outgoing call or receiving
incoming calls. 

Some TAPI drivers do not work on 64bit operating systems. You can use a virtual
machine with 32bit operating system. An example, how this is working is explained for 
MAC OS X.  For Windows Vista or Windows 7 64bit, the same virtual machines can be
used.

Operating System

Windows XP SP3 to Windows 7 (32bit and 64 bit) is supported
.NET 3.5 is required for the salesforce call center adapter 4

Browser Support

The following list of browsers are supported by salesforce.com for the call center adapter
4.0:

Minimum system requirements
IE8 +

150
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Firefox 3.5 +

Chrome 10 +

Safari 4+

While the adapter supports IE8 and Firefox 3.5 performance is significantly improved in
browsers like

IE9

Firefox 5 and 6

Chrome 13

Safari 5

It is recommended that the call center adapter 4.0 is used with browsers in the above list.

 The limitations are due to the salesforce call center adapter 4.0. Check  with the
next salesforce release if new Browser versions are supported.

Internet Explorer warning message

If you are running Internet Explorer and receive warnings which say “Do you want to view
only the webpage content that was delivered securely when using the browser” - see

Warning mixed content . -

Salesforce

The Salesforce Professional, Enterprise, Unlimited or Developer Edition is required for
the call center functionality. If you are using the Team Edition, contact Support@mirage-
systems.de for an alternative solution.

See also

Configure  the TAPI driver within CTI Data Connector for Salesforce
Where do I find the TAPI driver?
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8.8.3 Where do I find the TAPI driver?

Telephony Application Programming Interface (TAPI) is a  programming interface for
CTI (computer telephony integration) applications. 

Applications using TAPI need a TAPI driver (also referred to as TSP). This TAPI driver
has to be delivered by the phone manufacturer. As this driver is always device-
dependent, it is not possible to use a generic driver which is supplied with the operating
system. The driver often has the name of the manufacturer or the phone system,
sometimes in combination with the extension number.

To check whether a TAPI driver is installed, do the following (Instructions for Windows
XP).

Start, Control Panel

Phone and Modem options

TAB advanced

There are a lot of drivers which come with Windows like NDIS Proxy TAPI Service
Provider. Search for a driver with the name of the PBX, PBX vendor or your direct line.
If this driver is missing, you probably do not have the correct TAPI driver for your PBX.

If your TAPI driver is not listed here see: I cannot select my TAPI driver in the configuration
wizard 183
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See also

System Requirements - TAPI driver
Configure  the TAPI driver within CTI Data Connector for Salesforce

8.8.4 How do I activate CTI Data Connector for Salesforce?

During the trial period, the activation screen appears with each start of the program. You
need a Serial Number for activating the product - see Buy Serial Number .

You do not have to reinstall the version and you can directly activate it if: 

You have installed the trial version as a single user version and you bought a single user
version
You have installed the trial version as a network version and you bought a network
version

and

The version you have installed has the same version number like the version you
bought - see How can I check my version number?

 Always activate the software on a workstation and never on the server.

What happens during activation?

The activation process will connect the licence to the PC or Server. Use the Serial
Number only on the PC / Server you want to use CTI Data Connector for
Salesforce. The Serial Number cannot be used twice. After the activation is done, CTI
Data Connector for Salesforce will run only on this PC / Server. Your hardware data,
Serial Number, name, e-mail address and some program-specific data is transferred to
our activation center. No other data stored on your PC will be transmitted.

 The activation process can be done from any PC, even if you have a network
version (starting the activation process on the server is not possible)

Select Activation Method

On the first screen select: I have a Serial Number and I want to activate CTI Data
Connector for Salesforce. This will give you a selection how to activate the product.  The
Online Activation  is the recommended activation method and should be used if an
Internet connection is available. E-Mail Activation  can be used in case the online
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activation is blocked.

(note: the screen you see could be slightly different)

Message - Serial Number required

If you get the message, that a Serial Number is required, press the button Next and
select between online  and e-mail activation . A Serial Number is required. Without
a Serial Number the application can only be terminated using the End button.

138 140
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 Start Video Tutorial for product Activation

See also

Buy Serial Number
Online Activation
E-Mail Activation
Reinstall Software
Your CTI Data Connector for Salesforce License

8.8.5 Errors - Call Center Adapter

Error Messages

137

138

138

143

164

http://www.helpserver.biz/onlinehelp/cdc/tutorial/2.4/activation/product-activation-tutorial.htm
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The following errors could occur. After changing a configuration setting always
logout from salesforce.

If the adapter is generally working but the SoftPhone suddenly does not respond on

calls, right mouse click on the blue icon and select Restart Salesforce SoftPhone.
Then click on the Home TAB in Salesforce to refresh the page. If this happens
frequently, then change the value Timeout for http requests in the expert settings

Do you want to view only the web content that was delivered securely? (Warning mixed
content)

The warning can be disabled using the following steps:

Go to Tools -> Internet Options -> Security -> Local Intranet

97
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Click "Custom Level"

Select "Enable" for "Display mixed content"
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Click "OK"

Click "OK"

The call is signaled in the SoftPhone with a large delay - change the value for Polling
interval in salesforce adapter in the expert settings

Red error box: 500 stream:1: XML file has no top-element. All well-formed XML files
have a single top-level element. 

If a call center adapter from another vendor was installed on this computer, uninstall
this application and reinstall CTI Data Connector for Salesforce.

The other reason for this error is an installation issue with the Windows XML
subsystem, MSXML6, which has not been installed or properly registered. 

Login as administrator

97
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Navigate your Windows Explorer to c:\windows\system32

Double click on msxml6.dll.  It'll give you a window saying it doesn't know what to do
with it.  Select "select program from list."
In the ensuing window, press Browse.  There, type "c:\windows\system32\regsvr32"
and confirm the selection with OK

Red error box: Error connecting to the salesforce.com AppExchange API - the
SoftPhone does not load 

If you get this error, contact salesforce support to enable the API. The API is disabled
by default in a test account

If you are using Professional / Enterprise Edition or higher see: API is not enabled for
this Organization or Partner

Red error box: An Adapter for your Call Center was not found or could not be started.
Please contact your Salesforce.com administrator to rectify this issue

The error message indicates, that the Salesforce Adapter DLL could not be registered

In case you installed a call center adapter from other vendors uninstall it and delete
the adapter within salesforce

Quit CTI Data Connector for Salesforce (blue icon , right mouse click, Quit)

Install CTI Data Connector for Salesforce again using Windows Administrator
credentials
If the error persists send us a log file

Red error box: API is not enabled for this Organization or Partner

If you are using a test account see: Error connecting to the salesforce.com
AppExchange API - the SoftPhone does not load

157
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If you are using Professional / Enterprise Edition or higher, check the profile (Setup,
Administration Setup, Manage Users, Profiles) which is associated to the user.  There
is an option: API Enabled. This must be checked. Also verify if the option: Call
Center is checked with the option Visible 

Red error box: Unable to start the salesforce.com Office Tookit

DLLs have not been registered properly. Install CTI Data Connector for Salesforce
again using Windows Administrator credentials

Note for Administrators: The file SF_MSApi4.dll is not registered. It is in the folder c:
\program files\CTI Data Connector for salesforce 4.0\call center adapter and can be
manually registered using regsvr32

Red error box: Unable to start the softphone XML subsystem

This error means that the XML subsystem, MSXML6, has not been installed or properly
registered. Search "Unable to start the Softphone XML subsystem." in Salesforce.com
Help & Training for troubleshooting steps.

Download MSXML6 Parser .Restart Windows after installation

Note for Administrators: The file msxml6.dll is missing or not registered. It is in the
folder c:\windows\system32 and can be manually registered using regsvr32

Microsoft Visual C++ Debug Library

Error Message

http://www.microsoft.com/download/en/details.aspx?id=3988


159Installation

© 2012 Mirage Computer Systems GmbH

.

The error message indicates, that different versions of the Salesforce Adapter DLL are
installed

In case you installed a call center adapter from other vendors uninstall it and delete
the adapter within salesforce

Quit CTI Data Connector for Salesforce (blue icon , right mouse click, Quit)

Install CTI Data Connector for Salesforce again using Windows Administrator
credentials
If the error persists send us a log file

The SoftPhone does not load in Firefox or Safari

See Browser Support

Phone icon is grey

Right to the phone number there is a grey icon    instead of a green  icon or the
text: click to dial disabled is displayed when you click  on a phone number

Check if the red salesforce icon  is visible  See also System Tray icon. 

The icon is NOT visible
If the icon is not visible quit CTI Data Connector for Salesforce and start it again. If
the icon is still not visible

Check if an error in a red box appears

If there is no error message, install CTI Data Connector for Salesforce again
using Windows Administrator credentials

24
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If the error persists send us a log file

The icon is visible

Check if you get an API error

If the error persists send us a log file

Questions and Answers

Salesforce offers a web page with comprehensive information and questions and
answers 

Send Log File

In case an error cannot be solved, send us a log file

Right click on the red salesforce icon  . Then select Logging....  See also System
Tray icon. 
Check High - Errors, informational messages, and XML 

Quit CTI Data Connector for Salesforce (blue icon , right mouse click, Quit) and start
it again

Send both log files (browser_connector.log and cti_connector.log) to Support@mirage-
systems.de. You find the files in the folder 4.0\call center adapter.
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The integration in salesforce requires one of the following salesforce editions:  
Professional, Enterprise, Unlimited oder Developer Edition.

8.9 MAC OS X

CTI Data Connector for Salesforce can be used on MAC OS X in combination with 
Parallels Desktop for MAC (recommended) or VMware. As host operating system
Windows 7, 32bit is recommended.

Step 1 - Configuration Settings in Parallels Desktop 7

Find below recommended configuration settings.
The windows applications folder can be be displayed in the MAC Dock. You can start CTI
Data Connector for Salesforce with all installed applications by clicking on the icon 

Display Windows Application Folder in Dock

http://www.parallels.com/eu/products/desktop/


162 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

Step 2 - Install CTI Data Connector for Salesforce in the Virtual
Machine 

Within Windows 7, open the file Explorer (right mouse click, Windows Explorer) 

First, install the TAPI (TSP)  driver in the virtual machine. Then install  CTI Data
Connector for Salesforce

Single User Installation

Network Installation

Step 3 -  Advice how to use CTI Data Connector for Salesforce
in combination with the virtual machine

The virtual machine should be used in coherence mode. Windows is then 'invisible'
andCTI Data Connector for Salesforce works like a normal MAC OS X application. To
change to coherence mode Choose Enter Coherence from the virtual machine View
menu

During the first program start, the icon of  CTI Data Connector for Salesforce appears in
the dock. With right mouse click, Options, Keep in Dock, the icon is kept in the doc. IN
the future, you can start CTI Data Connector for Salesforce by clicking on the icon 

The Browser (see supported Browsers ) must be started from the virtual machine.
You can also add the Internet Explorer to the dock (right mouse click, Options, Keep in
Dock). You have to use this Browser in combination with salesforce

All options of CTI Data Connector for Salesforce with left or right mouse  click are not
available. The configuration wizard has to be started using the windows application

folder 

Step 4 -  Install on other workstations

The virtual machine can be used on other workstations. You have to observe the license
agreement of Parallels and Windows.
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9 Part II - Enhanced Features

These lessons explain CTI Data Connector for Salesforce features. It is mainly for
administrators. After completing them, you will have experience with these tasks:

License Information - chapter Your  CTI Data Connector for Salesforce License

How TOs and FAQ

Distribute Client Setup

9.1 Your CTI Data Connector for Salesforce License

CTI Data Connector for Salesforce comes with an own licence file - cdcsfe.lic. The

licence is a licence  PER PC / COMPUTER. Copy Protection is turned on after
activation. We recommend backing up the licence file and all Activation Keys  you got.

You have to activate the product before you can use it without the restrictions of the 
demo version  - see How do I activate CTI Data Connector for Salesforce

Find out more about your licence in the chapter - Show License Information

See License Agreement  for details of usage.

See also

Demoversion
Browse your License Information
Apply Activation Key
Deactivate a License

License Agreement

9.1.1 Demoversion

The Demoversion has the following restrictions:

Limited by days - normally 30 days 

All other parts of the application are fully functional
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9.1.2 Show License Information

To display the license information, either

right click on the icon in the taskbar  - select Show License Information

or 

select within the Control Centre , Menu Extras, Show License Information

This will open the Licence Viewer where you can view the licenses you have acquired, the
number of users/computers who can use the licence and whether a licence has a time
limitation or not. 

Number of licenses

The folder CTI License displays the maximum number of licenses and the number of
licenses which are available. If you click on the + sign, all computers using a license will
be displayed. See Deactivate a License  how to deactivate one single computer. 

Number of Computers / PCs which have a license

Demoversion  - if omitted it is a full version or time-limited full version

Valid until (time limitation) - if omitted it is a non time-limited version

Web Activation  - either done or required

Update Subscription

The update subscription entitles you to install the latest updates as long as it has not
expired. See chapter software update  about how to download updates.

Available / Not available

Time limitation - the date when the update subscription expires

Release Number

Internal release information
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9.1.3 Apply Activation Key

An Activation Key is used to modify the license information (e.g. increase number of
licenses). All Activation Keys are unique and have the same format like: 

fZDdq-aDC95-e54DA-atR82-DL82k-NfC4v

There are 6 blocks each with 5 characters. The blocks are separated by a hyphen for
better readability. 

If you got an Activation Key via E-Mail or Fax, you can enter the key within the screen
Show License Information .

Start screen Show License Information

Select button Activation Key

Paste the key from the clipboard with CTRL+V

 It is possible to validate the Activation Key online. In this case an Internet connection
is necessary.

77

77
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9.1.4 Deactivate a PC within a network

If a PC does not further need the license of  CTI Data Connector for Salesforce,  its
license can be deactivated. The license can then be used by another PC.

Start screen Show License Information

Click on the + sign before CTI License, then select the PC the license of which should
be deactivated
Press the button Deactivate. The name of the PC will be displayed in brackets - e.g.
(PC-2)

77
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Reactivate a license

The license can be activated again by selecting the deactivated PC and then pressing the
button Activate.
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9.1.5 Transfer license / Move to a new computer

You can move the license to a new computer (single user installation) or new server
(network installation). The license will be deactivated on the current computer / server.
The Serial Number can then be used again on another computer / server to activate the
product.

This process requires an online connection. You only can transfer a license for a full
version (no demo version).

Note

The functionality is available within a network installation only if the application is started
with cdcsfe -admin to prevent, that the license is transferred accidentally. A single PC
within a network can be always deactivated without an online connection - see Deactivate
a PC within a network .

Step 1 - Show License Viewer

Blue icon , right mouse click -  Show License Information

Step 2 - Transfer License

Click on the button Transfer License

167
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Button - Transfer License

Thereafter an information is displayed, that the license will be deactivated
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Screen - License Deactivation

Step 3 - Activate CTI Data Connector for Salesforce on a new
computer

You can reuse the Serial Number on a new computer to activate CTI Data Connector for
Salesforce 

 

After the license was deactivated, you can reactivate it during the next program start as
long as the Serial Number was not used on another computer
The license can be transferred multiple times between computers - Example: Transfer
license from PC A to PC B. Then deactivate on PC B and activate again on PC A
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9.1.6 License Agreement

PERPETUAL END USER LICENCE AGREEMENT

NOTICE TO ALL USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT
(‘AGREEMENT’), FOR THE LICENCE OF SPECIFIED SOFTWARE (‘SOFTWARE’) BY
Mirage Computer Systems GmbH (‘Mirage Computer Systems GmbH ’). BY CLICKING
THE ACCEPT BUTTON OR INSTALLING THE SOFTWARE, YOU (EITHER AN
INDIVIDUAL OR A SINGLE ENTITY) CONSENT TO BE BOUND BY AND BECOME A
PARTY TO THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF
THIS AGREEMENT, CLICK THE BUTTON THAT INDICATES THAT YOU DO NOT
ACCEPT THE TERMS OF THIS AGREEMENT AND DO NOT INSTALL THE
SOFTWARE.(IF APPLICABLE, YOU MAY RETURN THE PRODUCT TO THE PLACE
OF PURCHASE FOR A FULL REFUND.)

1. LICENCE Grant. Subject to the payment of the applicable LICENCE fees, and subject
to the terms and conditions of this Agreement, Mirage Computer Systems GmbH  hereby
grants to you a non-exclusive, non-transferable right to use one copy of the specified
version of the Software and the accompanying documentation (the ‘Documentation’). You
may install one copy of the Software on one computer, workstation, personal digital
assistant, pager, ‘smart phone’ or other electronic device for which the Software was
designed (each, a ‘Client Device’). If the Software is LICENSED  as a suite or bundle with
more than one specified Software product, this LICENSE applies to all such specified
Software products, subject to any restrictions or usage terms specified on the applicable
price list or product packaging that apply to any of such Software products individually.

a. Use. The Software is LICENSED as a single product; it may not be used on more than
one Client Device or by more than one user at a time, except as set forth in this Section 1.
The Software is ‘in use’ on a Client Device when it is loaded into the temporary memory
(i.e., random-access memory or RAM) or installed into the permanent memory (e.g., hard
disk, CD-ROM, or other storage device) of that Client Device. This LICENSE authorizes
you to make one copy of the Software solely for backup or archival purposes, provided
that the copy you make contains all of the Software’s proprietary notices.

b. Server-Mode. You may use the Software on a Client Device as a server (‘Server’)
within a multi-user or networked environment(‘Server-Mode’) only if such use is permitted
in the applicable price list or product packaging for the Software. A separate LICENSE is
required for each Client Device or ‘seat’ that may connect to the Server at any time,
regardless of whether such LICENSED Client Devices or seats are concurrently
connected to, accessing or using the Software. Use of software or hardware that reduces
the number of Client Devices or seats directly accessing or utilizing the Software (e.g.,
‘multiplexing’ or ‘pooling’ software or hardware) does not reduce the number of
LICENSES required (i.e., the required number of LICENSES would equal the number of
distinct inputs to the multiplexing or pooling software or hardware ‘front end’). If the
number of Client Devices or seats that can connect to the Software can exceed the
number of LICENSES you have obtained, then you must have a reasonable mechanism
in place to ensure that your use of the Software does not exceed the use limits specified
for the LICENSES you have obtained. This LICENSE authorizes you to make or download
one copy of the Documentation for each Client Device or seat that is LICENSED,
provided that each such copy contains all of the Documentation’s proprietary notices.
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c. Volume LICENSES. If the Software is LICENSED with volume LICENSE terms
specified in the applicable price list or product packaging for the Software, you may make,
use and install as many additional copies of the Software on the number of Client Devices
as the volume LICENSE authorizes. You must have a reasonable mechanism in place to
ensure that the number of Client Devices on which the Software has been installed does
not exceed the number of LICENSES you have obtained. This LICENSE authorizes you to
make or download one copy of the Documentation for each additional copy authorized by
the volume LICENSE, provided that each such copy contains all of the Documentation’s
proprietary notices.

2. Term. This Agreement is effective for an unlimited duration unless and until earlier
terminated as set forth herein. This Agreement will terminate automatically if you fail to
comply with any of the limitations or other requirements described herein. Upon any
termination or expiration of this Agreement, you must destroy all copies of the Software
and the Documentation.

3. Updates. For the time period specified in the applicable price list or product packaging
for the Software, you are entitled to download revisions or updates to the Software when
and as Mirage Computer Systems GmbH  publishes them via its electronic bulletin board
system, website or through other online services. For a period of thirty (30) days from the
date of the of original purchase of the Software, you are entitled to download one(1)
revision or upgrade to the Software when and as Mirage Computer Systems GmbH 
publishes it via its electronic bulletin board system, website or through other online
services. After the specified time period, you have no further rights to receive any
revisions or upgrades without purchase of a new LICENSE to the Software.

4. Ownership Rights. The Software is protected by German copyright laws and
international treaty provisions. Mirage Computer Systems GmbH  and its suppliers own
and retain all right, title and interest in and to the Software, including all copyrights,
patents, trade secret rights, trademarks and other intellectual property rights therein. Your
possession, installation, or use of the Software does not transfer to you any title to the
intellectual property in the Software, and you will not acquire any rights to the Software
except as expressly set forth in this Agreement. All copies of the Software and
Documentation made hereunder must contain the same proprietary notices that appear
on and in the Software and Documentation.

5. Restrictions. You may not sell, lease, LICENSE, rent, loan or otherwise transfer, with or
without consideration, rent, lease, loan or resell the Software. Mirage Computer Systems
GmbH  updates its Software frequently and performance data for its Software change.
Before conducting benchmark tests regarding this Software, contact Mirage Computer
Systems GmbH  to verify that you possess the correct Software for the test and the then
current version and edition of the Software. Benchmark tests of former, outdated or
inappropriate versions or editions of the Software may yield results that are not reflective
of the performance of the current version or edition of the Software. You agree not to
permit any third party (other than third parties under contract with you which contains
nondisclosure obligations no less restrictive than those set forth herein) to use the
LICENSED Program in any form and shall use all reasonable efforts to ensure that no
improper or unauthorized use of the LICENSED Program is made. You may not permit
third parties to benefit from the use or functionality of the Software via a timesharing,
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service bureau or other arrangement, except to the extent such use is specified in the
applicable price list, purchase order, or product packaging for the Software. You may not
transfer any of the rights granted to you under this Agreement. You may not reverse
engineer, decompile, or disassemble the Software, except to the extent the foregoing
restriction is expressly prohibited by applicable law. You may not modify, or create
derivative works based upon, the Software in whole or in part. You may not copy the
Software or Documentation except as expressly permitted in Section 1 above. You may
not remove any proprietary notices or labels on the Software. All rights not expressly set
forth hereunder are reserved by Mirage Computer Systems GmbH .

6. Warranty and Disclaimer.

a. Limited Warranty. Mirage Computer Systems GmbH  warrants that for sixty (60) days
from the date of original purchase the media (e.g., diskettes) on which the Software is
contained will be free from defects in materials and workmanship.

b. Customer Remedies. Mirage Computer Systems GmbH ’ and its suppliers’ entire
liability and your exclusive remedy for any breach of the foregoing warranty shall be, at
Mirage Computer Systems GmbH ’s option, either (i) return of the purchase price paid for
the LICENSE, if any, or (ii) replacement of the defective media in which the Software is
contained. You must return the defective media to Mirage Computer Systems GmbH  at
your expense with a copy of your receipt. This limited warranty is void if the defect has
resulted from accident, abuse, or misapplication. Any replacement media will be
warranted for the remainder of the original warranty period. Outside the United States, this
remedy is not available to the extent Mirage Computer Systems GmbH  is subject to
restrictions under United States export control laws and regulations.

c. Warranty Disclaimer. Except for the limited warranty set forth herein, THE
SOFTWARE IS PROVIDED ‘AS IS.’ TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, Mirage Computer Systems GmbH  DISCLAIMS ALL WARRANTIES,
EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
AND NONINFRINGEMENT WITH RESPECT TO THE SOFTWARE AND THE
ACCOMPANYING DOCUMENTATION. YOU ASSUME RESPONSIBILITY FOR
SELECTING THE SOFTWARE TO ACHIEVE YOUR INTENDED RESULTS, AND FOR
THE INSTALLATION OF, USE OF, AND RESULTS OBTAINED FROM THE
SOFTWARE. WITHOUT LIMITING THE FOREGOING PROVISIONS, Mirage Computer
Systems GmbH  MAKES NO WARRANTY THAT THE SOFTWARE WILL BE ERROR-
FREE OR FREE FROM INTERRUPTIONS OR OTHER FAILURES OR THAT THE
SOFTWARE WILL MEET YOUR REQUIREMENTS.

7. Limitation of Liability. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL
THEORY, WHETHER IN TORT, CONTRACT, OR OTHERWISE, SHALL Mirage
Computer Systems GmbH  OR ITS SUPPLIERS BE LIABLE TO YOU OR TO ANY
OTHER PERSON FOR ANY INDIRECT, CONSEQUENTIAL OR PURELY FINANCIAL
DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF GOODWILL,WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION,
OR FOR ANY AND ALL OTHER DAMAGES OR LOSSES. IN NO EVENT WILL Mirage
Computer Systems GmbH  BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE LIST
PRICE Mirage Computer Systems GmbH  CHARGES FOR A LICENSE TO THE
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SOFTWARE, EVEN IF Mirage Computer Systems GmbH  SHALL HAVE BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION OF LIABILITY SHALL
NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT
THAT APPLICABLE LAW PROHIBITS SUCH LIMITATION.

8. United States Government. The Software and accompanying Documentation are
deemed to be ‘commercial computer software’ and’ commercial computer software
documentation,’ respectively, pursuant to DFAR Section 227.7202 and FAR Section
12.212, as applicable. Any use, modification, reproduction, release, performance, display
or disclosure of the Software and accompanying Documentation by the United States
Government shall be governed solely by the terms of this Agreement and shall be
prohibited except to the extent expressly permitted by the terms of this Agreement.

9. Export Controls. You have been advised that the Software and Documentation (the
‘Products’) are subject to the U.S. Export Administration Regulations. You shall not export,
import or transfer Products contrary to U.S. or other applicable laws, whether directly or
indirectly, and will not cause, approve or otherwise facilitate others such as agents or any
third parties in doing so. You represent and agree that neither the United States Bureau of
Export Administration nor any other federal agency has suspended, revoked or denied
your export privileges. You agree not to use or transfer the Products for end use relating
to any nuclear, chemical or biological weapons, or missile technology unless authorized
by the U.S. Government by regulation or specific LICENSE. Additionally, you acknowledge
that the Products are subject to export control regulations in the European Union and You
hereby declare and agree that the Products will not be used for any other purpose than
civil (non-military) purposes. The parties agree to cooperate with each other with respect
to any application for any required LICENSES and approvals, however, You acknowledge
it is Your ultimate responsibility to comply with any and all export and import laws and that
Mirage Computer Systems GmbH  has no further responsibility after the initial sale to You
within the original country of sale.

10.High Risk Activities. The Software is not fault-tolerant and is not designed or intended
for use in hazardous environments requiring fail-safe performance, including without
limitation, in the operation of nuclear facilities, aircraft navigation or communication
systems, air traffic control, weapons systems, direct life-support machines, or any other
application in which the failure of the Software could lead directly to death, personal injury,
or severe physical or property damage (collectively, ‘High Risk Activities’). Mirage
Computer Systems GmbH  expressly disclaims any express or implied warranty of
fitness for High Risk Activities.

11.Miscellaneous. This Agreement is governed by the laws of Germany, without reference
to conflict of laws principles. The application of the United Nations Convention of
Contracts for the International Sale of Goods is expressly excluded. This Agreement sets
forth all rights for the user of the Software and is the entire agreement between the
parties. Mirage Computer Systems GmbH  reserves the right to periodically audit you to
ensure that you are not using any Software in violation of this Agreement. During your
standard business hours and upon prior written notice, Mirage Computer Systems GmbH
 may visit you and you will make available to Mirage Computer Systems GmbH  or its
representatives any records pertaining to the Software to Mirage Computer Systems
GmbH . The cost of any requested audit will be solely borne by Mirage Computer
Systems GmbH , unless such audit discloses an underpayment or amount due to Mirage
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Computer Systems GmbH  in excess of five percent (5%) of the initial LICENSE fee for
the Software or you are using the Software in an unauthorized manner, in which case you
shall pay the cost of the audit. This Agreement supersedes any other communications
with respect to the Software and Documentation. This Agreement may not be modified
except by a written addendum issued by a duly authorized representative of Mirage
Computer Systems GmbH . No provision hereof shall be deemed waived unless such
waiver shall be in writing and signed by Mirage Computer Systems GmbH  or a duly
authorized representative of Mirage Computer Systems GmbH . If any provision of this
Agreement is held invalid, the remainder of this Agreement shall continue in full force and
effect. The parties confirm that it is their wish that this Agreement has been written in the
English language only.

12.Mirage Computer Systems GmbH  CUSTOMER CONTACT. If you have any questions
concerning these terms and conditions, or if you would like to contact Mirage Computer
Systems GmbH  for any other reason, please E-Mail: Support@mirage-systems.de. You
will find our internet web- site at 
www.cti-data-connector.com

Date: October 2010
LA-DE-01082003

9.2 How TOs and FAQ

This chapter introduces Frequently Asked Questions as well as tips and tricks.

9.2.1 How can I print this Tutorial

Print this tutorial

The Online Tutorial is also available as a PDF document.

You can print this tutorial - click on the link to download PDF file 

9.2.2 How do I activate CTI Data Connector for Salesforce?

During the trial period, the activation screen appears with each start of the program. You
need a Serial Number for activating the product - see Buy Serial Number .

You do not have to reinstall the version and you can directly activate it if: 

You have installed the trial version as a single user version and you bought a single user
version
You have installed the trial version as a network version and you bought a network
version

and

137
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The version you have installed has the same version number like the version you
bought - see How can I check my version number?

 Always activate the software on a workstation and never on the server.

What happens during activation?

The activation process will connect the licence to the PC or Server. Use the Serial
Number only on the PC / Server you want to use CTI Data Connector for
Salesforce. The Serial Number cannot be used twice. After the activation is done, CTI
Data Connector for Salesforce will run only on this PC / Server. Your hardware data,
Serial Number, name, e-mail address and some program-specific data is transferred to
our activation center. No other data stored on your PC will be transmitted.

 The activation process can be done from any PC, even if you have a network
version (starting the activation process on the server is not possible)

Select Activation Method

On the first screen select: I have a Serial Number and I want to activate CTI Data
Connector for Salesforce. This will give you a selection how to activate the product.  The
Online Activation  is the recommended activation method and should be used if an
Internet connection is available. E-Mail Activation  can be used in case the online
activation is blocked.

(note: the screen you see could be slightly different)

201
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Message - Serial Number required

If you get the message, that a Serial Number is required, press the button Next and
select between online  and e-mail activation . A Serial Number is required. Without
a Serial Number the application can only be terminated using the End button.

138 140
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 Start Video Tutorial for product Activation

See also

Buy Serial Number
Online Activation
E-Mail Activation
Reinstall Software
Your CTI Data Connector for Salesforce License

9.2.3 System Requirements - TAPI driver

Telephone System

To communicate with a phone system, either a CTI server (Third Party Solution) or the

137
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connection of the phone set to the PC (First Party Solution) is supported. For both
systems a TAPI driver 2.x (also referred to as TSP) is mandatory. See details for TAPI
- Where do I find the TAPI driver?

VOIP systems like Cisco Call Manager, Avaya, Swyx or Innovaphone normally have a
TAPI driver included. 
For Asterisk there are several vendors who offer a TAPI driver e.g. http://
www.xtelsio.com or http://activa.sourceforge.net.
If your VOIP / Cloud PBX system does not comes with a TAPI driver, try Global IP
Telecommunications Ltd (Ninja Pro) www.globalipphones.com . This software works
with all SIP compatible phone systems.
Traditional PBX systems like Siemens or Alcatel often require an additional TAPI server.

ISDN phones without a PBX are available with an inbuilt TAPI driver. 

If you are using a modem, we strongly recommend switching to a phone set connected
to the PC (via USB/serial), because the TAPI drivers of modems often do offer only
basic functions or do not function at all. 

Please check firstly with your phone vendor about which solution meets your
requirements and how you can install and configure the TAPI driver. You can contact
Support@mirage-systems.de if you do have the TAPI driver installed and CTI Data
Connector for Salesforce has problems with making an outgoing call or receiving
incoming calls. 

Some TAPI drivers do not work on 64bit operating systems. You can use a virtual
machine with 32bit operating system. An example, how this is working is explained for 
MAC OS X.  For Windows Vista or Windows 7 64bit, the same virtual machines can be
used.

Operating System

Windows XP SP3 to Windows 7 (32bit and 64 bit) is supported
.NET 3.5 is required for the salesforce call center adapter 4

Browser Support

The following list of browsers are supported by salesforce.com for the call center adapter
4.0:

Minimum system requirements
IE8 +

Firefox 3.5 +

Chrome 10 +

Safari 4+

While the adapter supports IE8 and Firefox 3.5 performance is significantly improved in
browsers like

150
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IE9

Firefox 5 and 6

Chrome 13

Safari 5

It is recommended that the call center adapter 4.0 is used with browsers in the above list.

 The limitations are due to the salesforce call center adapter 4.0. Check  with the
next salesforce release if new Browser versions are supported.

Internet Explorer warning message

If you are running Internet Explorer and receive warnings which say “Do you want to view
only the webpage content that was delivered securely when using the browser” - see

Warning mixed content . -

Salesforce

The Salesforce Professional, Enterprise, Unlimited or Developer Edition is required for
the call center functionality. If you are using the Team Edition, contact Support@mirage-
systems.de for an alternative solution.

See also

Configure  the TAPI driver within CTI Data Connector for Salesforce
Where do I find the TAPI driver?

9.2.4 Where do I find the TAPI driver?

Telephony Application Programming Interface (TAPI) is a  programming interface for
CTI (computer telephony integration) applications. 

Applications using TAPI need a TAPI driver (also referred to as TSP). This TAPI driver
has to be delivered by the phone manufacturer. As this driver is always device-
dependent, it is not possible to use a generic driver which is supplied with the operating

154

54

150



182 CTI Data Connector 4.0

© 2012 Mirage Computer Systems GmbH

system. The driver often has the name of the manufacturer or the phone system,
sometimes in combination with the extension number.

To check whether a TAPI driver is installed, do the following (Instructions for Windows
XP).

Start, Control Panel

Phone and Modem options

TAB advanced

There are a lot of drivers which come with Windows like NDIS Proxy TAPI Service
Provider. Search for a driver with the name of the PBX, PBX vendor or your direct line.
If this driver is missing, you probably do not have the correct TAPI driver for your PBX.

If your TAPI driver is not listed here see: I cannot select my TAPI driver in the configuration
wizard

See also

System Requirements - TAPI driver
Configure  the TAPI driver within CTI Data Connector for Salesforce
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9.2.5 I cannot select my TAPI driver in the configuration wizard

If you cannot select the TAPI driver in the configuration wizard  (it does not appear in
the list), then check:

Step 1: Phone and Modem options
Is the TAPI driver visible in Phone and Modem options ? Typically you see either the
name of the PBX or your extension number.

If the TAPI driver is not visible here, install it again and reboot the system.

If the TAPI driver is listed here, continue with step 2

Step 2: Configure the TAPI driver

Some TAPI drivers have to be configured, e.g. you have to add the IP address where to
find the PBX or add a user name and password. This is done in Phone and Modem
options . Select your driver and click on the button: Configure.

Check again if the TAPI driver can be selected in the configuration wizard

If it is still missing, continue with step 3

Step 3: Start telephony service

If you are running windows 7, then some TAPI drivers require the telephony service.

Go to Administrative Tools in the Control Panel and click Services

Change the startup type of the Telephony service to automatic and reboot the system. If
the TAPI driver is still not visible in the configuration wizard, there is a setup problem with
the TAPI driver. Contact the PBX vendor
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9.2.6 Minimum Configuration Settings

During installation, the Configuration Wizard  was already started. You can define a lot
of individual configuration settings there. The following settings have to be defined to
guarantee a basic functionality.

TAPI device driver  - it is delivered by the telephone manufacturer. See also: System
requirements - TAPI driver  . If you don't have a TAPI driver yet, you can use the
Telephone Simulator  for testing.
Button Dialing Rules  - configures country settings and area code. See also special
configuration for US / Canada

Just by setting this minimum configuration you will be able to make outgoing calls and to
identify incoming calls. The Configuration Wizard can be started any time by right click
on the icon , option Configuration Wizard .
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See also

Where do I find the TAPI driver?
System requirements - TAPI driver

 
 

9.2.7 Troubleshooting - Outgoing calls

If outgoing calls do not always or never work, then first perform the following checks: 

Errors - Call Center Adapter

I cannot select my TAPI driver in the configuration wizard

Necessary configuration settings for outgoing calls

Outgoing call - never possible  

Outgoing call - dials wrong number / prefix

Outgoing call - Dial with Hyperlink not working

Outgoing call - Postfix like # necessary
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Outgoing call - problem with Internal Number

Outgoing call - Hotkey is not working

If the problem cannot be located, CTI Data Connector for Salesforce can log all events
coming from the TAPI driver. Often wrong implementations of the TAPI driver or functions
not implemented like call transferring are causing problems. Our support team can
analyze the log file. 

To send us a log file - see How do I send a log file?

9.2.7.1 Necessary configuration settings for outgoing calls

Below find a list of configuration settings which have an impact on outgoing calls. If
outgoing calls are not working, check these settings and also check Troubleshooting -
Outgoing calls .

Configuration Settings

Select correct TAPI driver

PBX Configuration  - especially dial tone digits for external calls

Dialing Rules  - for US / Canada check additional settings

TAPI Configuration - Prefix Outgoing Calls

TAPI Configuration - Provider Postfix

TAPI Configuration - Ignore Fake Number

Dial via Hotkey  - configure  Hotkey and activate this option

Dial within Browser  - activate this option

Dial with a Hyperlink  - activate this option

If internal numbers are not dialled correct, check:

TAPI Configuration - Prefix internal number

Minimum length  of phone number indicating an external call

9.2.7.2 Outgoing Call - never possible

If you are not able to make an outgoing call, perform the following checks: 

Start the Configuration Wizard  

Browse to the page where you can select the TAPI driver  and select the correct TAPI
driver. See also Where do I find the TAPI driver?  
Press button Finish 

Select Quick dialing

Type in a phone number an select Dial 

If the number is dialed but with a wrong prefix (a wrong number is placed in front or
numbers are missing), check solution Outgoing Call - wrong Prefix . 
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If dialing works with Quick dialing but you can not dial with a Hotkey , change the Hotkey
 within the Configuration Wizard. 

If outgoing calls are still not working, make a test with Windows Phone Dialer. Select in
Windows: Start, Run: Dialer.exe

You can select and configure the TAPI driver in this application and make a phone call.

If outgoing calls are not working with the Phone Dialer, the reason for the problem is the
TAPI driver. Contact your phone vendor.

If outgoing calls are working with the Phone Dialer, send us a log file .

9.2.7.3 Outgoing Call - wrong Prefix

If outgoing calls are working, but the prefix is wrong (a wrong number is placed in front
or numbers are missing) or the number has a wrong format, perform the following
checks: 

Start the Configuration Wizard

Browse to the page PBX Configuration  

Select button dialing Rules . 

Select your location and press Edit 

The Country/Region setting is important. Select your country and enter the Area code
without any prefix like 0 or 1

DO NOT use dialing rules - they are only supported for US / Canada - see dialing Rules
for US / Canada  
Check the Dial tone digits for external calls . This is the number to get an outside line,
normally 0 or 9. 
Enter the Minimum length of phone number indicating an external call . If the
maximum INTERNAL phone number has a length of 3 digits, you have to enter 4 here
Activate the Desktop Notification for outgoing calls to get each call signaled

Press button Finish 

Select Quick dialing

Type in a phone number an select Dial 

If the number is dialed correctly but no caller data is displayed, try to cut a prefix for an
outside line, e.g. 9 or 0. This can be configured within Expert Settings, TAPI configuration
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. Do also check the option Ignore Fake Numbers .

If the number is still wrong, try other settings. 

If dialing still does not work, send us a log file .

9.2.7.4 Outgoing Call - Dial with Hyperlink not working

Dialing with an hyperlink is supported in all Browsers. You have to activate this function
within the Configuration Wizard - see Configure dial options for Browsers . Make sure
that you have disabled the feature in Skype. See also: Expert Settings, Miscellaneous
Settings, Application to dial with Hyperlink .

To dial via an hyperlink in a Browser based application, just insert the following command
in your application:

<a href="callto://phonenumber">Click to Dial</a>

where phonenumber has to be replaced with the real phone number like

<a href="callto://+4970054885342">Click to Dial</a>
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9.2.7.5 Outgoing Call - Postfix like # necessary

If a character like # has to be added after each phone number (postfix), configure this
option in Expert Settings, TAPI Driver.

9.2.7.6 Outgoing Call - problem with Internal Number

Check the following configuration settings:

Minimum length of phone number indication an external call  - this is the main
configuration setting to determine if a call is internal or external
Activate the Desktop Notification window for outgoing calls to get each call signaled

The configuration option: Don't show internal calls  must be unchecked to trace the
call in the Desktop Notification window
If the internal number is e.g. signaled with 12 but the number stored in the database is
07342/7383-12, see in Prefix for Internal Numbers  how to add the company number
and area code

9.2.7.7 Outgoing Call - Hotkey is not working

If you try to dial with a Hotkey , and nothing happens, perform the following checks:

Firstly check if you can dial with the Quick dialing option. If this is also not possible (the
phone does not dial anything), check Outgoing Call - never possible . 

If the phone dials, the Hotkey settings have to be modified:

Try a Hotkey which is not used like CTRL+SHIFT+F10 - change the Hotkey here

Especially in case the Hotkey is sometimes working and sometimes not, increase the
Clipboard waiting time in increments of 10 - change the waiting time here

9.2.8 Troubleshooting - Incoming calls

If incoming calls do not always or never work, firstly perform the following checks: 

Errors - Call Center Adapter

I cannot select my TAPI driver in the configuration wizard

Necessary configuration settings for caller identification

Incoming call - never signalled

Incoming call - wrong prefix

Incoming call - Caller Identification not working

Incoming call - use address data stored in PBX

Incoming call - problem with Internal Number

If the problem cannot be located, CTI Data Connector for Salesforce can log all events
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coming from the TAPI driver. Often wrong implementations of the TAPI driver or functions
not implemented like call transferring are causing problems. Our support team can
analyze the log file. 

To send us a log file - see How do I send a log file?

9.2.8.1 Necessary configuration settings for caller identification

Below is a list of configuration settings which have an impact on the caller identification. If
the caller identification is not working, check these settings and also check 
Troubleshooting - Incoming calls .

Address information used for caller identification
Salesforce Lead, Account, Contact

Addresses stored in the PBX system

Configuration Settings

Select correct TAPI driver

Configuration Caller Identification

TAPI Configuration - truncate incoming phone number at

TAPI Configuration - Prefix incoming call

TAPI Configuration - Don’t signal updated phone number during a call

If internal numbers are not identified correct, check:

TAPI Configuration - Prefix internal number

Minimum length  of phone number indicating an external call

9.2.8.2 Incoming Call - never signalled

If an incoming call is never signalled, perform the following checks: 

Start the Configuration Wizard  

Browse to the page where you can select the TAPI driver  and select the correct TAPI
driver. See also Where do I find the TAPI driver?  
Activate the Desktop Notification window for incoming calls to get each call signaled

Press button Finish 

Call with your mobile phone and make sure that you do not suppress the phone
number from your mobile

If the number is signalled but with a wrong prefix, check the solution Incoming Call -
wrong Prefix  

If incoming calls still do not work, send us a log file .
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See also

Incoming call - wrong address information is displayed

 

9.2.8.3 Incoming Call - wrong Prefix

If the number of an incoming call is signaled but with a wrong prefix (e.g. 
0070054885342), try to cut a prefix e.g. 9 or 0. 
If the leading 0 is missing (e.g. 70054885342), add 0 for incoming calls.

This can be configured within Expert Settings, TAPI configuration .

9.2.8.4 Incoming Call - Caller Identification not working

If the number of an incoming call is signaled, but the caller can not be identified, firstly
perform the following checks:

If you get the wrong caller signalled, change the value for Caller Identification - truncate
number of digits  to a value between 1 to 3
Make sure that the number is stored in your database or MS-Outlook

If you are using MS-Outlook / Exchange, make sure you have the right Outlook folder
selected
If you are using a single user installation, firstly perform Format Phone Numbers  

If you have your address information stored in the PBX, check Incoming Call - use
address data from PBX
If you are using a network installation, either test with a number stored in MS-Outlook or
have the administrator perform the synchronization of the the phone numbers on the
server
If the number is signaled with a wrong prefix (e.g. 0070054885342), check Incoming
Call - wrong Prefix
If the number is signaled with additional characters (e.g. 070054885342@xy.com),
truncate the incoming phone number at the @ sign - check Expert Settings, TAPI
Configuration
If only internal calls are not identified, check Incoming Call - problem with Internal
Number

9.2.8.5 Incoming Call - use address data stored in PBX

If the address data is stored in the PBX or phone, this data can be used additionally for
caller identification. Enable Display Caller ID Name identified by PBX.
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9.2.8.6 Incoming Call - wrong address information is displayed

If you often get into the situation that multiple addresses are displayed in combination with
the text Caller could not be identified exactly, this is due to the feature of truncating phone
numbers. Reduce the number of digits which are truncated - see settings Caller
Identification truncate number of digits

In Europe - use either 3 or 2

In USA / Canada - always use 0

9.2.8.7 Incoming Call - problem with Internal Number

Check the following configuration settings:

Minimum length of phone number indication an external call  - this is the main
configuration setting to determine if a call is internal or external
Activate the Desktop Notification window for incoming calls to get each call signaled

The configuration option: Don't show internal calls  must be unchecked

If the internal number is e.g. signaled with 12 but the number stored in the database is 
07342/7383-12, see in Prefix for Internal Numbers  how to add the company number
and area code

9.2.9 Errors - Call Center Adapter

Error Messages

The following errors could occur. After changing a configuration setting always
logout from salesforce.

If the adapter is generally working but the SoftPhone suddenly does not respond on

calls, right mouse click on the blue icon and select Restart Salesforce SoftPhone.
Then click on the Home TAB in Salesforce to refresh the page. If this happens
frequently, then change the value Timeout for http requests in the expert settings

Do you want to view only the web content that was delivered securely? (Warning mixed
content)
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The warning can be disabled using the following steps:

Go to Tools -> Internet Options -> Security -> Local Intranet

Click "Custom Level"

Select "Enable" for "Display mixed content"
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Click "OK"

Click "OK"

The call is signaled in the SoftPhone with a large delay - change the value for Polling
interval in salesforce adapter in the expert settings

Red error box: 500 stream:1: XML file has no top-element. All well-formed XML files
have a single top-level element. 

If a call center adapter from another vendor was installed on this computer, uninstall
this application and reinstall CTI Data Connector for Salesforce.

The other reason for this error is an installation issue with the Windows XML
subsystem, MSXML6, which has not been installed or properly registered. 
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Login as administrator

Navigate your Windows Explorer to c:\windows\system32

Double click on msxml6.dll.  It'll give you a window saying it doesn't know what to do
with it.  Select "select program from list."
In the ensuing window, press Browse.  There, type "c:\windows\system32\regsvr32"
and confirm the selection with OK

Red error box: Error connecting to the salesforce.com AppExchange API - the
SoftPhone does not load 

If you get this error, contact salesforce support to enable the API. The API is disabled
by default in a test account

If you are using Professional / Enterprise Edition or higher see: API is not enabled for
this Organization or Partner

Red error box: An Adapter for your Call Center was not found or could not be started.
Please contact your Salesforce.com administrator to rectify this issue

The error message indicates, that the Salesforce Adapter DLL could not be registered

In case you installed a call center adapter from other vendors uninstall it and delete
the adapter within salesforce

Quit CTI Data Connector for Salesforce (blue icon , right mouse click, Quit)

Install CTI Data Connector for Salesforce again using Windows Administrator
credentials
If the error persists send us a log file

Red error box: API is not enabled for this Organization or Partner

If you are using a test account see: Error connecting to the salesforce.com
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AppExchange API - the SoftPhone does not load

If you are using Professional / Enterprise Edition or higher, check the profile (Setup,
Administration Setup, Manage Users, Profiles) which is associated to the user.  There
is an option: API Enabled. This must be checked. Also verify if the option: Call
Center is checked with the option Visible 

Red error box: Unable to start the salesforce.com Office Tookit

DLLs have not been registered properly. Install CTI Data Connector for Salesforce
again using Windows Administrator credentials

Note for Administrators: The file SF_MSApi4.dll is not registered. It is in the folder c:
\program files\CTI Data Connector for salesforce 4.0\call center adapter and can be
manually registered using regsvr32

Red error box: Unable to start the softphone XML subsystem

This error means that the XML subsystem, MSXML6, has not been installed or properly
registered. Search "Unable to start the Softphone XML subsystem." in Salesforce.com
Help & Training for troubleshooting steps.

Download MSXML6 Parser .Restart Windows after installation

Note for Administrators: The file msxml6.dll is missing or not registered. It is in the
folder c:\windows\system32 and can be manually registered using regsvr32

Microsoft Visual C++ Debug Library

Error Message

157

http://www.microsoft.com/download/en/details.aspx?id=3988
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.

The error message indicates, that different versions of the Salesforce Adapter DLL are
installed

In case you installed a call center adapter from other vendors uninstall it and delete
the adapter within salesforce

Quit CTI Data Connector for Salesforce (blue icon , right mouse click, Quit)

Install CTI Data Connector for Salesforce again using Windows Administrator
credentials
If the error persists send us a log file

The SoftPhone does not load in Firefox or Safari

See Browser Support

Phone icon is grey

Right to the phone number there is a grey icon    instead of a green  icon or the
text: click to dial disabled is displayed when you click  on a phone number

Check if the red salesforce icon  is visible  See also System Tray icon. 

The icon is NOT visible
If the icon is not visible quit CTI Data Connector for Salesforce and start it again. If
the icon is still not visible

Check if an error in a red box appears

If there is no error message, install CTI Data Connector for Salesforce again
using Windows Administrator credentials
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If the error persists send us a log file

The icon is visible

Check if you get an API error

If the error persists send us a log file

Questions and Answers

Salesforce offers a web page with comprehensive information and questions and
answers 

Send Log File

In case an error cannot be solved, send us a log file

Right click on the red salesforce icon  . Then select Logging....  See also System
Tray icon. 
Check High - Errors, informational messages, and XML 

Quit CTI Data Connector for Salesforce (blue icon , right mouse click, Quit) and start
it again

Send both log files (browser_connector.log and cti_connector.log) to Support@mirage-
systems.de. You find the files in the folder 4.0\call center adapter.

160
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http://wiki.developerforce.com/page/Troubleshooting_Your_CTI_Adapter#Is_there_a_wrap-up_timer.2C_or_can_I_add_one.3F
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The integration in salesforce requires one of the following salesforce editions:  
Professional, Enterprise, Unlimited oder Developer Edition.

9.2.10 How do I send a log file?

If a problem can not be located, CTI Data Connector for Salesforce can log all events
coming from the TAPI driver. Often wrong implementations of the TAPI driver or functions
not implemented like call transferring are causing problems. Our support team can
analyze the log file. 

To send us a log file, perform the following steps: 

Start the Configuration Wizard (CTI Data Connector for Salesforce icon, right mouse
click, Configuration Wizard) 
Browse to step 1 (depending on the program version this can be another page) and
select the Button Expert Settings  
Check Activate call logging 

Press button OK, then button Finish 

CTI Data Connector for Salesforce starts. Now perform the operation that is not
working correctly, e.g. make an incoming call with your mobile phone 

Everything is now logged into a file

Start the Configuration Wizard (CTI Data Connector for Salesforce icon, right mouse
click, Configuration Wizard) 
Browse to step 1 (depending on the program version this can be another page) and
select the Button Expert Settings  
Press the button Send Log File. Your e-mail client opens. Add a detailed description of
the problem and the exact phone numbers which do not work. Send the e-mail.
Uncheck Activate call logging

Press button OK, then button Finish 

9.2.11 Special requirements for Access database in a network environment

If an Access Database is used in a network environment, it could never be backed up as
long as CTI Data Connector for Salesforce is running.

Enable the configuration option: Terminate database connection after each call  on
each client PC and disable this option on the server which performs the phone
number formatting .

9.2.12 How to use the Called ID (my number) for caller identification?

By default, the phone number of the person who is calling (CallerID) is used for caller
identification. If the number which was called (Called ID) should be used, select the
option Use Called ID for caller identification .
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9.2.13 How can I suppress the notification of internal calls?

By default, internal calls are signalled. Check the configuration option: Don't show internal
calls

9.2.14 How can I dial with an Hotkey?

In nearly any application a phone number can be highlighted and dialed using the Hotkey
defined in the configuration settings . The default value is the key F10.

Highlight the phone number within the Web Browser by pressing down the left mouse key
and dragging the mouse cursor to the right. When reaching the end of the phone number,
release the left mouse button and press F10.
In the example below a phone number has been highlighted. It can be dialed using the
defined Hotkey.

See also

Troubleshooting - Hotkey is not working
Configuration - Hotkey to dial with a highlighted phone number
Configuration - Activate dialing via Hotkey
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9.2.15 How can I dial with an Hyperlink?

You can dial with a Hyperlink in Browser applications. To use this functionality, the
application has to be modified. Dialing via Hyperlink allows to dialing just with a click.

To dial via a hyperlink in a Browser based application, just insert the following command
in your application: 

<a href="callto://phonenumber">phonenumber</a> 

where phonenumber has to be replaced by the real phone number like 

<a href="callto://+4970054885342">+4970054885342</a> 

It is displayed on the screen as follows:  +4970054885342

To enable dialing via hyperlink open the Configuration Wizard and check Activate dialing
via Hyperlink .

 This function is available in all Browsers (e.g. Internet Explorer or Firefox).

See also

Enable Dial with a Hyperlink 
Troubleshooting - Dial with a Hyperlink is not working
Configuration - Application used for dialing with Hyperlink

 

9.2.16 How can I speed up dialling?

Often dialling of a phone number can be accelerated by using an additional character -
especially when using an IP phone or software.

The configuration of the additional character (e.g. #) can be done in the Configuration
Wizard, Expert Settings,  Provider Postfix .

9.2.17 How can I check my version number?

Right mouse click on the icon and select Open CTI Data Connector for Salesforce. Select
menu ?, About CTI Data Connector for Salesforce. You will find the detailed version
number there.
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To check for the latest updates, select menu ?, Software Service.

9.2.18 How do I uninstall CTI Data Connector for Salesforce

To uninstall CTI Data Connector for Salesforce 

Select Start, Control Panel

Add/Remove Programs

Search for CTI Data Connector for Salesforce 4.0 and select Remove.

9.2.19 I found no answer for my questions

If you did not find an answer for your questions in the tutorial search in the extensive
Online Knowledge Base.

Browse Online Knowledge Base

http://www.mirage-systems.de/cdc/kb.html
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